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A. Login & Authentication 

I. Login 

1. Antelope 6 Cloud supports the following types of login authentication: 
a. Simple username and password input. 

2. Input the username and password. 

antelope 
Cloud Version 

SIGN IN TO MY ACCOUNT 

Forgot Password 

Antelope 6 AI Genie Version 6 

3. Select the language. Currently Antelope supports English, Traditional Chinese, Simplified 
Chinese and Portuguese. 

4. Click "Remember Me" if you want the browser to remember your username. 

5. Click "SIGN IN TO MY ACCOUNT" button. By default, if you attempt login fail for more 
than 10 times, system will lock your account for 30 minutes. The number of fail attempt 
will vary according to system administrator setup. 
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II. Forget Password 

1. If you forget your user account password, click the "Forget Password" link on the bottom 
of the login page. 

Forgot Password 
To safeguard your account, we will send you a link for changing your password by 
email. 

Please enter your registered email address: 

SEND BACK 

2. Input the email address which is associated with your user account. 

3. Click "Send" button. 

4. You will receive an email about resetting password for your Antelope user account. Click 
the hyperlink embedded in the email. 

5. Input your new password. 

6. Click the "Change" button. 

7. You can now login again with your new password. 
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B. My Account 

I. Avatar 

1. From the top right-handed corner, click the user icon. 

@­ 

My Account 

My Shared Links to Guest 

My Reminder Record 

2. The context menu will appear. Select "My Account". 

3. To change your profile picture, click the circle icon from Avatar. 

My Account Update x 

Password and Signature Others 

Avatar 

JT 

4. From the Upload Document pop-up window, click the "Choose File" button. 

5. Select your profile picture. Antelope only supports JPG and PNG format. It is 

recommended the profile picture should be under 500 x 500 pixels resolutions. 

6. Click the "Upload" button. 
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II. Password 

1. To update password, Input your current one from "Password". 

Password 

New Password 

Confirm Password 

2. Input your new password and confirm password. All passwords must follow the rules 
below: 

• Password length with a minimum of 8 characters 
• At least 1 upper case letter, 1 lower case letter, 1 numeric letter and 1 symbol. 

Ill. Signature 

1. Click the grey Signature area. 

Signature 

2. The "Add Signature" window will appear. 
Add Signature Upload x 

Clear 

••• 
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3. There are three options for defining your signature: 

Option Description 

Draw Draw your signature by pointing device such as mouse. 

Type Type your signature with a selection of cursive fonts. 

Upload Upload your signature file in either JPG or PNG format. 

4. Click the "Clear" hyperlink to clear your signature. 

5. Click the "Upload" button to save your signature. 
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C. Dashboard 

I. Dashboard mode and web part introduction 

The Antelope dashboard simplifies the retrieval of necessary information and provides a 
comprehensive overview of all your processes. 

1. If you are the first-time login into the system, you will see two webparts displayed in the 
dashboard: Workflow lnbox and Workflow Outbox. This is the "Normal" mode, in which 
all web parts are displayed in a single page. = Name » Keyword Search 

Home 

Folders Dashboard 

• [] Quik Access 

[ My check out 

[a) My Favorites 

]My Clipboard 

(O) Recent Open Documents 

[] Personal Folder 

? Home 

» [] Agreements 

» ] Bil of Lading 
> CJ Correspondence Letter 

» HR 
» D 1voices 

> C 
> Marketing 

> CJ Personal Folders 

» 7 Poets 
» [] sales Reports 

Advanced Search 

Workflow Inbox 

Workflow No. 

Workflow Name 

Received On 

r 
Task Name 

[l) 

Workflow Outbox r 
Sent on Task Name Status 

Workflow Applications [l) 

2. At the top right-handed corner, there is a "Personal" pull-down list which allows you 
to select different dashboards. 

I- Ca 
3. The pull-down list includes what user group(s) you belongs to. In this example, you 

also belongs to Marketing (MKT) user group, which has its own dashboard. 
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4. Select the Marketing option (or user group which your account belongs to). This will 
display another dashboard. Different dashboard may have different setting and 
configuration, please consult your system or departmental administrator. = Name v Keyword Search 

gs Home 

Folders 

• [] Quick Access 

[a My check out 

[) My Favorites 

] My Clipboard 

Q) Recent Open Documents 

3 Personal Folder 

? Home 

> CJ Agreements 

[] Bil of Lading 

> CJ Correspondence letter 

»DC HR 

» [7 1voices 

» DC 
» [) Marketing 

> CJ Personal Folders 

Advanced Search 

Project Dashboard Workflow Template Workflow Inbox O Workflow Outbox 

Project Dashboard 

Linnovate 

e) No task due in 2 Weeks 

" 

g 
Project Module Development 

0 5 tasks due in 2 weeks 

) 3 tasks past due 

MKT 

SampleCorp 

e) No task due in 2 We 

Tasks due in 2 Weeks No. of Tasks Due in 2 Weeks 

Project Name Task Owne r(s) 

Workflow Applications 
Linnovate admin 

System 

( 

I 

5. Depends on your access permission, if you do not have rights to modify your user 
group dashboard, you won't able to see the blue edit button on the right-handed 
side, as below:- 

~M_KT v ~[ I MKT V 

No access permission Access permission granted 
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II. Edit the dashboard 

1. To edit your current dashboard, click the top right-handed side blue button. 

Personal V ad 
2. Your dashboard will change into edit mode. = Name » Keyword Search 

Home 

Folders Normal 

• ] Quick Access 

[a My check out 

[ My Favorites 

]My Clipboard 

(O) Recent Open Documents 

} Personal Folder 

C? Home 

» [] Agreements 

> CJ Bill of Lading 

> CJ Correspondence Letter 

» HR 

> 1voices 

Workflow Inbox 

» 
» ] Marketing 

Workflow Inbox 

(lxl( 

Workflow Outbox 

Workflow Outbox 

(lxl( 

3. The blue pencil button will change into save button. 

Personal 

4. There are three dashboard modes for you to select: Normal, Horizontal Tab and 
Vertical Tab. Select "Horizontal Tab" from the top left-handed corner pull-down list. 

Name » Keyword Search 

Home 

Folders Ill . • [ Quick Access 

[ My check out 

[) My Favorites 

]My Clipboard 

(O) Recent Open Documents 

} Personal Folder 

C7 Home 

> CJ Agreements 

» [] Bill of Lading 
> CJ Correspondence letter 

» HR 

> 1voices 

» DC 
» [] Marketing 

» [_]Personal Folders 

Workflow Inbox 

[x1] 

Workflow Outbox 

Workflow Outbox 

[1xd] 
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5. Click the blue save button to commit changes. 

Personal V 

6. The dashboard will change into horizontal tab mode. = Name » Keyword Search 

Home 

Folders 

• [ Quick Access 

Workflow Inbo workflow Outbox 

Workflow Inbox 

(!l My Check Out 

~ My Favorites 

□ My Clipboard 

@ Recent Open Documents 

ca Personal Folder 

• ? Home 

» []Agreements 

> D Bill of Lading 

> D Correspondence letter 
> D HR 

» [ 1voices 

» C 
» [] Marketing 

> []Personal Folders 

Advanced Search 

Workflow Applications 

Workflow No. Received On Task Name 

System 
(l] 

7. For vertical tab mode, all web part tabs will align to the left-handed side of the 
screen. = Name e Keyword Search 

us Home 

Folders Personal 

• [ Quick Access Workflow Inbox o 
Workflow Inbox 

Workfl ow No. Received On 

r 

(!l My Check Out 

~ My Favorites 

□ My Clipboard 

@ Recent Open Documents 

c Personal Folder 
? Home 

» []Agreements 

» [] Bill of Lading 
> CJ Correspondence Letter 

> D HR 

» ] invoices 

Workflow Outbox 

» C 
» [) Marketing 

» [_]Personal Folders 

Advanced Search 

Workflow Applications 
(l] 

System 
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Ill. Add a new web part 

1. Change the dashboard into edit-mode. = Name » Keyword Search 

Home 

Folders Horizontal Tab 

• ] Quick Access 

[a My check out 

[a) My Favorites 

[] My Clipboard 

(O) Recent Open Documents 

3 Personal Folder 

C7 Home 

> CJ Agreements 

> CJ Bill of Lading 

> CJ Correspondence Letter 

» HR 
» [ 1voices 

Workflow Inbox 

» C 
» Marketing 

» [] Personal Folders 
Advanced Search 

Workflow Inbox 

[11] 

Workflow Outbox 

Workflow Outbox 

[11] 

Workflow Applications 

System 

2. Click the rounded add button from the bottom. 

Workflow Outbox 

[lxl] 

3. The "Add Web Part" window will appear. 
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4. Use the following setting: 
Add Web Part Add X 

Add to row 

New Row 

Type 

Notifications (MySubList) 

Height 

1X 

Width 

1X 

5. Click "Add" button to commit changes. 

6. The "Add Web Part" window will be closed. 

7. The dashboard is still in edit-mode, click the blue save button from the top right­ 
handed corner to commit changes. = Name » Keyword Search 

Home 

Folders Horizontal Tab v Personal 

us a 
• [ Quick Access 

Workflow Inbox 

[ My chek out 

[ My favorites 

(] My Clipboard 

(O) Recent Open Documents 

[2 Personal Folder 

- 3 Home 

» Account 

» ) Agreements 

» [_] correspondence Letter 
» [_Human Resources 

» _] Information Technology 

» uany 
) Management 

> Marketing 

» [ offi ce Administration 

[_)Persona Folders 

Advanced Search 

Workfl ow Inbox 

[lxl] 

Workflow Outbox 

Workflow Outbox 

[] 

Notifications 

Notifications 

[lxl] 

Workflow Applications 

System @ 

8. A new web part is added to your dashboard. 

Workflow Inbox @@ workflow Outbox 

Notifications 

Status Type File Name 

Notifications 

Owner 
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IV. Delete an existing web part 

1. Change the dashboard into edit-mode. = Name » Keyword Search x q A 0 @ 

Home 

Folders Horizontal Tab v Personal 

us a 
• [ Quick Access 

[ My chek out 

[ My favorites 

] My Clipboard 

(O) Recent Open Documents 

[2 Personal Folder 

- 3 Home 

» Acount 

» ) Agreements 

» [_] correspondence Letter 
» [_Human Resources 

» _] Information Technology 

» uany 
) Management 

> Marketing 

» [ offi ce Administration 

[_)Persona Folders 

Advanced Search 

Workflow Inbox 

Workflow Inbox 

[lxl] 

Workflow Outbox 

Workflow Outbox 

[] 

Notifications 

Notifications 

[lxl] 

Workflow Applications 

System @ 

2. Move the mouse cursor to Notifications webpart. 

3. Click the rounded cross icon. 

Notifications j 
[lxl] 

4. The web part is deleted. 
Name v eyword Search 

Home 

Folders Horizontal Tab v 

• [ Quick Access 

[ My chek out 

[a) My Favorites 

[9 My Clipboard 

(O) Recent Open Documents 

3 Personal fFolder 
• C2 Home 

» Account 

> ) Agreements 

» [_] Correspondence Letter 
» [_ Human Resources 

» [_ Information Technology 

> uray 
» )Management 

Workflow Inbox 

Workflow Inbox 

[lxl] 

Workflow Outbox 

Workflow Outbox 

[1] 

@ 
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V. Add a new web part to existing row 

1. Change the dashboard into edit-mode. 

= Name e Keyword Search 

Home 

Folders Horizontal Tab v 

• [ Quick Access 
Workflow Inbox 

[ My check out 

[ My Favorites 

] My Clipboard 

(O) Recent Open Documents 

3 Personal Folder 

2 Home 
» 7 A«count 

] Agreements 

» [_) correspondence Letter 

» [_ Human Resources 

» [_ Information Technology 

> uray 
» [] Management 

> Manetin9 
» [ office Administration 
» [_) Personal Folders 

Workflow Inbox 

[d) 

Workflow Outbox 

Workflow Outbox 

[1] 

@ 

Advanced Search 

Workflow Applications 

System 

2. Move the mouse cursor to Workflow In box webpart. 

3. Click the rounded add icon. 

Workflow Inbox 

[lxl] 

4. The "Add Web Part" window will appear, use the following setting: 
Add Web Part Add X 

Add to row 

Workflow lnbox 

Type 

Recently Accessed (Access) 

Height 

1X 

Width 

1X 

5. Click the "Add" button to commit changes. 
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6. The "Recent Accessed" web part is added in front of Workflow In box web part. = Name e {eyword Search 

Home 

Folders Horizontal Tab v 

• [] Quick Access 

[a My check out 

[ My Favorites 

] My Clipboard 

(@) Recent Open Documents 

] Personal Folder 

• C7 Home 

» Acount 

> ) Agreements 

» [_] correspondence Letter 
» [Human Resources 

» [_ Information Technology 

> C unary 
» Management 

» [7Marketing 

> CJ Office Administration 

» [_) Persona Folders 

Recently Accessed 

Recently Accessed 

[1] 

Workflow Inbox 

[1] 

Workflow Outbox 

Workflow Outbox 

[lxl[ 

@ 

Advanced Search 

Workflow Applications 

System 

7. Click the blue save button from the top right-handed corner to commit changes. 

= Name » Keyword Search 

Home us 
Folders Recently Accessed Workflow Outbox Personal a 
V Quick Access 

Recently Accessed r Workflow Inbox a 

a My Check Out File Name Modified Date Workflow No. 

[!'I My Favorites a D Legal Matters 2024-05-22 15.0C 

LI My Clipboard ® D Correspondence Letters 2024-05-22 15.0c 
(O) Recent Open Documents 

® D Draft Documents 2024-05-22 15.0c 
3 Personal Folder 

® D Organisation Charts 2024-05-22 15.00 
V ? Home 

» Account 
a D Company Registries 2024-05-22 14.5s 

» J Agreements a D Agreements 2024-05-22 14.5s 

» [_] correspondence Letter a D Management 2024-05-22 14.5& 

» [Human Resources a D Supplier List 2024-05-22 14.5& 

» [_] Information Technology a D Letter Head 2024-05-22 14.5& 
» uray 

® D Floor Plan 2024-05-22 14.5& 
» ) Management 
> Marketing 

® D CCTV Diagram 2024-05-22 14.5& 

» [ office Administration ® D Fire Drill & Exhauster 2024-05-22 14.5& 

» [_) Persona Folders a D Office Administration 2024-05-22 14.57 

Advanced Search a D Server & Network Diagrams 2024-05-22 14.55 

Workflow Applications a D IT Suppliers 2024-05-22 14.55 
[I] 

System 

« a 0 @- 

Page 20 



Antelope 6 Workspace User Manual Documentation 

VI. Enlarge an existing web part 

1. Change the dashboard into edit-mode. = Name » Keywo rd Search 

Home 

Folders Horizontal Tab 

• ) Quick Access 
Recently Accessed 

[ My Chek out 

[) My Favorites 

9 My Clipboard 

(O) Recent Open Documents 

3 Personal Folder 
• C2 Home 

> C Account 
> [ Agreements 

» [_] Correspondence Letter 

» [Human Resources 

» [_ information Technology 

> uray 
Management 

» 7 Marketing 

» [_ offi ce Administration 

» _)Personal Folders 

Advanced Search 

Recently Accessed 

[lxl ] 

Workflow Inbox 

[lxl ] 

Workflow Outbox 

Workflow Outbox 

[lxl ] 

Workflow Applications 

System 

2. To enlarge the width of an existing web part, click the first arrow icon. 

Recently Accessed @ 

[ 

[lxl] 

t ➔

3. The web part width is enlarged with a ratio of [2 x 1 ]. 

Recently Accessed 

Recently Accessed 

[2x1] 

Workflow Inbox 

[lxl) 

4. Click the first arrow icon again to enlarge further with a ratio of [3 x 1 ]. 

I➔

Recently Accessed 

[2xl] 

[­ 

@ 

➔
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5. When the width of the web part reaches a ratio of [4 x 1], the remaining web part will 
move to the next row. = Name e Keyword Search 

Home 

Folders Horizontal Tab v 

[J Quid Access 
Recently Accessed 

[ My check out 

[ My Favorites 

] My Clipboa rd 

(O) Recent Open Documents 

3 Personal Folder 
2 Home 

» Account 

J Agreements 

» [_) correspondence Letter 
» [_Human Resources 

» [_ Information Technology 

> uray 
» [] Management 

Marketin 

Recently Accessed 

[3d] 

Workflow Inbox 

[d] 

Workflow Outbox 

Workflow Outbox 

[1] 

@ 

Recently Accessed at [3x 1] ratio 

Name v Keyword Search 

Home 

Folders Horizontal Tab v 

• [ Quick Access 
Recently Accessed 

[ My chek out 

[ My Favorites 

(C]My Clipboard 

(O) Recent Open Documents 

[2 Personal Folder 

2 Home 
» C Account 
[] Agreements 

» [_ Correspondence Letter 
» [_Human Resources 

» [_] Information Technology 

» uray 
> Management 

» [Marketing 

» [ office Administration 

» [_) Persona Folders 

Recently Accessed 

[A1] 

Workflow Inbox 

[1] 

Workflow Outbox 

Workflow Outbox 

[d) 

Advanced Search 

Workflow Applications 

System 

@ 

Recently Accessed at [4 x 1] ratio 

6. To shrink the ratio, click the left arrow icon. 

Recently Accessed 

[­ 

[4xl] 

s ➔
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7. Similarly, to enlarge the height of the web part, click the down arrow. 

@ 

I➔

Recently Accessed 

[3xl] 

[­ ➔

8. The web part height is enlarged. = Name Keyword Search 

Home 

Folders Horizontal Tab v 

• [J Quick Access 
Recently Accessed 

[ My check out 

[ My Favorites 

] My Clipboard 

(O) Recent Open Documents 

3 Personal Folder 
• 2 Home 

> Acount 

» [Agreements 

» [_) correspondence Letter 

» [_Human Resources 

» [ information Technology 

> ubray 

» [_Management 

> 7 Marketing 

» [_ office Administration 

» _)Personal Folders 

Advanced Search 

Workflow Inbox 

[d) 

Recently Accessed 

[32) 

Workflow Outbox 

Workflow Outbox 

[1] 

@ 

Workflow Applications 

System 

9. To move the web part to the right, click the right arrow on the most right. 

Recently Accessed @ 

I➔ [K- 

[3x2] 

v ➔
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10. This will interchange the position between two web parts. = Name » Keywo rd Search 

Home 

Folders Horizontal Tab v 

• ) Quick Access 

[ My Check out 

[a) My Favorites 

(O] My chipboard 

(O) Recent Open Documents 

3 Personal Folder 
• C2 Home 

> CJ Account 
» [Agreements 

» [_] Correspondence Letter 

» [Human Resources 

» [_ Information Technology 

> Curry 
> Management 

] Marketing 

» [ office Administration 

» [_) Personal Folders 

Workflow Inbox 

Workflow Inbox 

[1) 

Recently Accessed 

[3x2] 

Workflow Outbox 

Workflow Outbox 

[x1 

Advanced Search 

Workflow Applications 

System 

VII. Rename a web part 

1. To rename a web part, click the web part name. 

Workflow Inbox 

[lxl] 

2. Input the new name of the web part. 

Workflow Incoming Tasks 

[lxl] 

3. Click the blue save button from the top right-handed corner to commit changes. 

Workflow Incoming Tasks & workflow Outbox 

Workflow Incoming Tasks 

► Workflow No. 
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VIII. Rename a tab 

1. To rename a tab, click the tab name. = Name e Keywo rd Search 

Home 

Folders Horizontal Tab v 

• [ Quick Access 
Workflow Inbox 

[ My check out 

[ My Favorites 

] My Chipboa rd 

(O) Recent Open Documents 

3 Personal Folder 

• 2 Home 
> CJ Account 
» [Agreements 

» [_) correspondence Letter 

» [_]Human Resources 

> CJ Information Technology 

» unary 

» [_ Management 

> 7 Marketing 

» [_ office Administration 
» _)Personal Folders 

Advanced Search 

Workflow Inbox 

[d 

Workflow Outbox 

Workflow Outbox 

[1] 

@ 

Workflow Applications 

System 

2. Input the new name of the tab. 
Horizontal Tab 

My Process 

Workflow Inbox 

[lxl] 

3. Click the blue save button from the top right-handed corner to commit changes. 

My Process @ 
Workflow Inbox 

►

Workflow Outbox 

Workflow No. 
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D. Searching 

I. Name Search 

1. To search for folder and document name, select the folder which you want to search. For 
example, if you want to search for the entire folder tree, you should select the root folder 
(e.g. Home). = Name e Keyword Search 

Home 

Folders 

• [] Quick Access 

[ My check out 

[a) My Favorites 

] My Clipboard 

O) Recent Open Documents 

[] Personal Folder 

C7 Home 
» [] Agreements 

» Bill of Lading 
> [J Correspondence letter 

> HR 

> 1voices 

» DC 
» [] Marketing 

» [_] Personal Folders 

Advanced Search 

Workflow Applications 

System 

Workflow Template Workflow Inbo Workflow Outbox 

Workflow Template 

Personal 

us a 
Type here to filter template 

Information Technology 

Human Resources 

- 
Request for Salary Proof 

letter 

All Staffs 

Account & Finance 

2. From the top blue bar, select "Name" as search type. 

/ Name 
Content 

Keyword Search 

3. Input the search keyword (e.g. agreement). 

Name Y agreement 

4. Press "Enter" or click the search icon. 
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5. The search result will display, click the hyperlink to open the objects. 
Name e agreement 

Home us 
Folders 

Advanced Search 

Deross Profile 

Folder Path 

Home 

Document Content 

Index h 

D - [Fite Name 

. D * 7 . Agreement Signing Schedule 

D * . Agreements 

D * » . Real Estate Purchase Agreement.pdf 

D * » . Residential Lease Agreement.pdf 

D * » . Sample Purchase Agreement.pdf 

e 
Size Version Version Date 

1to5(Page1) » > 

Version By 

1.0 2024-05-07 11.17.59 

2024-04-04 12.05.04 

227KB 1.0 2024-04-04 12.05.08 Administrator 

106KB 1.0 2024-04-04 12.20.33 Administrator 

116KB 1.0 2024-04-05 15.57.07 Jennifer Tam 

Document Profile 

General 

File Name se like e » 

+ and 

Search Results 

Workflow Applications 

System 

Note: Name Search does not support folders under "Quick Access". 

II. Full-Text Search 

1. To search documents by its content, select the folder which you want to search. For 
example, if you want to search for the Agreement folder, you should select it before 
searching (e.g. Home\Demo Purpose\Agreements & Contracts). 

2. From the top blue bar, select "Content" as search type. 

/ Name 

MditMii 
Keyword Search 

3. Input the search keyword (e.g. agreement). I Content v I agreement 

4. Press "Enter" or click the search icon. - 
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5. The search result will display, click the hyperlink to open the objects. 
Home > Demo Purpose > Agreements & Contracts 

Folders Index v OD e 1to2(Page1) v > 

Advanced Search □ [ ue Name Size Version Created Date Version Date 

Folder Path 

Home\Demo Purpose\Agreements &amp; 

Document Content 

agreement 

Document Profile 

General 

□
□

' , ' Confidential Agreeement - Redaction.pdf 411 KB 

°l 

Versi 

10 2022-11-26 2022-11-26 16.5345 Clem 

Demonstration Purpose Confidential Agreement this is Alan typing, please comment CONFIDENTIAL AGREEMENT A 

Confidential Agreeement.do 715 KB 3.1 2022-08-16 2024-05-22 1711.45 Clem 

AGREEMENT Antelope International Limited THIS DOCUMENT IS FOR DEMONSTRATION PURPOSE ONLY CONFI 

File Name se like 

+ and 

Search Results 

] Content contain agreement 

Ill. Advanced Search 

1. Advanced search, or index search, is for searching documents according to their 
document profiles and index fields. Click the "Advanced Search" tab on the left-hand side 
column. 

Name v Keyword Search 

Home > Account > In,o;m - 

Advanced Search 

q 
Cross Profile 

Folder Path 

Home\Account\invoices 

Document Content 

Document Profile 

Invoices 

File Name v like 

+New T Upload Index View 

□ [pile Name 

□ tr » . INV24001 pdf 

□ tr » . INV24002. pdf 

□ tr a . INV24003. pdf 

□ tr » . INV24004.pdf 

□ tr » . INV24005.pdf 

Edit Columns Recycle Bin e 
Size Version Version Date Version By 

200 KB 20 2024-05-22 12.34.31 DSO 

205 KB 2.0 2024-05-22 12.33.44 DSO 

205 KB 2.0 2024-05-22 1233.50 DSO 

191 KB 2.0 2024-05-22 12.34.46 DSO 

205 KB 2.0 2024-05-22 1233.57 DSO 

1to5(Page1) v 

Hash Tag Invoice 

INV24001 

SampleCorp #PO123 INV24002 

INV24003 

INV24004 

INV24005 

se » 

+ and 

2. The "Folder Path" and "Document Profile" is already selected for you. 

Folder Path 

Home\Account\lnvoices 

Document Content 

Document Profile 

Invoices 

File Name like v 
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3. For example, if you want to search all invoices within June 2024, select "Invoice Date >= 
2024-06-01". 

Document Profile 

Invoices 

Invoice Date > v 

[2024-06-01 

+ and 

4. Click the add button [+]to add another search field, select "Invoice Date <= 2024-06­ 
30". 

Document Profile 

Invoices 

Invoice Date 

2024-06-01 

Invoice Date 

s > 

< 

and 

v 

v 

2024-06-30 

5. Finally click the search icon to perform the advanced search. 

Advanced Search 

Q 41 

6. The search result will display on the document list panel. 
Name e Keyword Search 

Home > Account > Invoices 

Folders Index ?' 1to1(Page1) » 

Advanced Search [le Name 

• 7 a - INV24005.pdf 

Size Version Version Date Version By 

205KB 2.0 2024-05-22 12.33.57 DSO 

Hash Tag Invoice N 

INV24005 

Folder Path 

Home\Account\invoices 

Document Content 

Document Profile 

Invoices 
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IV. Save Search Template 

1. After you perform an advanced searching, your search setting will be listed at the bottom 
of the panel. 

Invoice Date 

2024-06-30 

+ 

< 

and 

v 

Search Results 

[] Invoice Date >= 2024-06-01 a... 

[] Invoice Date >= 2024-06-01 a... 

2. To save your search setting for future use, click the flag icon. c::J 

3. The "Save Search Template" window will appear. Input a "Template Name" for your 
search template. 

Save Search Template Save x 

Template Name 

[ Invoice within June 2024 

Personal 

Shared 

4. If you want to save the search template for personal use, select the "Personal" checkbox. 
Save Search Template Save x 

Template Name 

Invoice within June 2024 

Personal 

O 
Shared 
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5. If you want to share your search template to other users, select the "Shared" checkbox, 
and then select the folder you want to save in. 

Save Search Template Save x 

Template Name 

Invoice within June 2024 

Personal 

Shared 

O 
Folder Path 

Home\Account\invoices 

6. Note: If you do not save your search template, once you refresh the web browser screen, 
all your search history will be cleared. 

V. Load Search Template 

1. Once your personal search template is saved, it will appear in the Advanced Search 
panel. 

Search Template 

x Invoice within June 2024 

For shared search template, go to the folder that you saved the template . 

? Home 

v CJ Account 
v CJ Invoices 

• Invoice within June 2024 

2. Click the template "Invoice within June 2024" to load your search template. 
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3. Antelope will perform the search result for you. 
Name v Keyword Search 

• IE 
Folders 

Advanced Search 

plo Index 

□ - [pile Name 

. □ tr » INV24005.pdf 

Size Version Version Date 

' 1to1(Page1) » » 
Hash Tag 

205KB 2.0 2024-05-22 1233.57 «Ds 

Version By 

INV24005 

Cross Profile 

Folder Path 

Home\Account\invoices 

Document Content 

Document Profile 

Invoices 

File Name v like v » 

+ and 

Search Template 

X Invoice within June 2024 

VI. Delete Search Template 

1. To delete the personal search template, click the cross icon. 

Search Template 

x Invoice within June 2024 

To delete the shared search template, right-click to bring up the context menu, select 
More> Delete. 

"'lnvoiceY · · · · 
More Temporary Permission 

Delete 

Permission 

2. A confirmation message "Are you sure to delete?" will appear. 

3. Click "Confirm" to delete the search template. 
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E. Quick Access 
I. My Check-Out 

1. Under "Quick Access\ My Check Out", the folder lists out all your check-out documents. 
Name v Keyword Search 

Quick Access > My Check Out 

Folders 

[) Quick Access 

[} My check out 

[ My Favorites 

9 My Clipboard 

Q) Recent Open Documents 

3 Personal Folder 

> 2 Home 

View V 

□
□ Iii 
□ Iii 
□ Iii 

[ pile Name 

e 
Size Check Version Version Date 

Out On 

1to3 (Page1) v > 

Version By 

7 ta » INV24001pdf 152KB 2024-09- 1.0 2024-08-31 15.57.39 Jennifer Tam 

* - . Non-disclosure agreement.docx 85 KB 2024-09- 2.0 2024-09-01 01.33.34 Jennifer Tam 

a - Residential Lease Agreement.pdf 106 KB 2024-09- 1.0 2024-06-28 13.28.21 Antelope 

2. Click the document link to open for preview. 
, 

Non-disclosure agreement.docx x 

The file is checked out by Jennifer Tam 

EEEu 
3. You can preview the document by the document viewer. 

@ Home> Samples > Agreements > Non-disclosure agreement.do < @ Xx 

? Edit Relation Share To Compare Index Reminder Redaction AI Genie 

[] e! x 

3sarplecor 

View se 

Sample Non-Disclosure Agreement (NDA) 

Ver 2.0 / by Jennifer Tam 'a 

This Purchase Agreement ("Agreement") is made and entered into on this 22 day of June, 
2024, by and between: 

SampleCorp Innovation 
Address: Flat A, 10/F, SampleCorp Innovation Tower, Causeway Bay, Hong Kong 
("Seller") 

and 
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4. To unlock the document, right-click to bring up the context menu, select "Edit > Unlock". 
New View v [E ? < 

□
L a 
EI a 
a 

T File Name Size Check Version Version Date 
Out On 

? a - INV24001.pdf 

e id. van ate 

tr Residential 

152KB 2024-09­ 

B 2024-09­ 

1.0 2024-08-311 

2.0 2024-09-01 0 
Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

• s? 06-281 
Check Out & Edit 

Download 

Upload 

Convert To PDF 

Unlock 

Update Thumbnail 

Add Attachment 

II. My Favorites 

1. You can click the "Star" icon to mark any objects as favorites, including document, 
calendar, hyperlink, folder and workflow records. 
+ New V T Upload Index View V Change Column View Recycle Bin & 

□ l File Name Size Version Version Date Version By 

□ tr En . 329509.pdf 129 KB 1.0 2024-09-01 14.19.05 Jennifer Tam 

□ t En . 329510.pdf 125 KB 1.0 2024-09-01 14.19.05 Jennifer Tam 

□ tr EE» . 329511.pdf 145 KB 1.0 2024-09-01 14.19.05 Jennifer Tam 

□ tr EE» . 329512.pdf 123 KB 2.0 2024-09-01 14.19.08 Jennifer Tam 

□ tr E» . 329513.pdf 122 KB 1.0 2024-09-01 14.19.05 Jennifer Tam 

2. To view all marked favorites objects, go to "Quick Access\ My Favorites". 
Keyword Search 

Quick Access > My Favorites 

Folders View v D ' 1to1(Page1) » 

• [J Qu ick Aess 

[ My check out 

[ My Favorites 

[] My clipboard 

(O) Recent Open Documents 
[Q Personal Folder 

ti­ 
[ I 

[pile Name Size Version Version Date Version By Folder Path 

329510.pdf 125KB 10 2024-09.-01 14.19.05 Jennifer Tam Home\Samples\Accounting\invoices 

3. Click the "Star" icon again to remove from favorites. 
View v [E 

□
□

[ ile Name 

aa - 329510.pdf 

Size Version Version Date Version By 

125 KB 1.0 2024-09-01 14.19.05 Jennifer Tam 
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Ill. My Clipboard 

1. To add a document to clipboard, select the document, right click to bring up the context 
menu, then select "Add to My Clipboard". 
+ New V 7 Upload 

□
E 

Index View 

f File Name 

INV24001.pdf 

Size 

Change Column View 

Version 

Recycle Bin 

TV 

Preview 

Version Date 

e 

Version By 

1 2024.09.31 15:57.39 Jennifer Tam 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

2. You can add multiple documents to clipboard. 
Name v Keyword Search 

Quick Access > My Clipboa<d - 

Folders 

i] Quick Access 

[a My Check out 

[} My Favorites 

{] My clipboard 

(O) Recent Open Doc uments 

] Personal Folder 

8 

[ l [iie Name Sire Version Version Date Version By 

n (; » INV24001.pdf 152 KB 10 2024-08-31 15.57.39 Jennifer Tam 

□ do Sample.pptx 687 KB 10 2024-08-31 12.34.55 Antelope 

e 1to2(Page1) » 

Folder Path 

Home\Samples\Accounting\invoice (2024) 

Home\QC Profile A (Cojack) 

Note: My Clipboard only stores documents temporarily, like search history. It will be 
cleared once you refresh your page or log out. 

IV. Recent Open Documents 

1. Recent Open Documents display all your recently preview documents. 
Keyword Search « a t 0 @ 

Quick Access > Recent Open Documents rs» 
Folders e 1 to 14 (Page 1) V > 
V ] Quick Access □ File Name Size Version Version Date Version By Folder Path 

G My Chec k Out □ tr En . 329512.pdf 123 KB 2.0 2024-09-01 14.19.08 Jennifer Tam Home\Samples\Accounting\Invoices 

l.i My Favo rites [ I * En . 329513.pdf 122 KB 1.0 2024-09-01 14.19.05 Jennifer Tam Home\Samples\Accounting\Invoices 

LI My Clipboa rd □ tr En . 329509 .pdf 129 KB 10 2024-09-01 14.19.05 Jennifer Tam Home\Samples\Accounting\invoices 

Q) Rec ent Open Documents □ tr En . 329511.pdf 145 KB 10 2024-09-01 14.19.05 Jennifer Tam Home\Samples\Accounting\invoices 

3 Personal Folder □ tr En . 329510.pdf 125 KB 10 2024-09-01 14.19.05 Jennifer Tam Home\Samples\Accounting lnvoices 

tr al . Non-disclosure agreement.doc 85 KB 20 2024-09-01 01.33.34 Jennifer Tam Home\Samples\Agreements 
> 2 Home d * Ea . INV24001.pdf 152 KB 10 2024-08-31 15.57.39 Jennifer Tam Home\Samples\Accounting\invoice (202 

d tr » . Residential Lease Agreement.pdf 106 KB 10 2024-06-28 132821 Antelope Home\Samples\Agreements 

tr a . Sample Purchase Agreement.dox 89 KB 20 2024-09-01 01.16.25 Jennifer Tam Home\Samples\Agreements 

□ tr En . PO-15000 1.pdf 124 KB 10 2024-07-08 11.35.14 Antelope Home\Samples\Accounting\Purchase Or 

□ tr al . Word.doc 24 KB 10 2024-08-31 13.4327 Antelope Home\Doc Type Prev iew Test 

[ I tr de . PowerPoint.ppt 3 MB 10 2024-08-31 13.44 .15 Antelope Home\Doc Type Preview Test 

□ * au . 2023 4 9 1RR R 1 .9 W .ls 22 KB 10 2024-08-31 123322 Antelope Home\QC Profile A (CK) 

□ tr n . Word.rtf 46 KB 10 2024-08-31 1343.27 Antelope Home\Doc Type Preview Test 

2. It will show the most recent 50 documents. 
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V. Personal Folder 

1. Personal folder contains all tasks and documents you have been working on personally. 

Keyword Search 

Quick Access » Personal Folder 

New Upload hew 

e De Quick Access 

[ My Chee k out 

[ My Favorites 

[7] My clipboard 

) Recent Open Document s 

3 Personal Folder 

» 2Home 

] ­ 
} 
} 
} 
} 

'Fie Name Size Version Version Date 

4. Antelope 6 GENE AN en3.0.does zoKB 1.0 2024 -09-11 09.49.1s 

r - .Legal industry solution 1.24.pt 31MB 1.0 2024-09-11 09.s0.01 

l , Pie3pg 346KB 1.0 2024-09-11 09.4823 

4.update erust template guide.doe« 13kB 1.0 2024-06-21 16.5401 

Version By 

An telope 

An telope 

An telope 

An telope 

Wordlow Applications 

F. Folder 

I. Create New Folder 

1. To create a new folder, select a location from the folder tree. For example, the Marketing 
folder. 

2. From the "New" pull-down menu, select "Folder". 

} New V Up 

Folder 

L New Folder Tree 

ii New Calendar 

EE New Project 

Page 36 



Antelope 6 Workspace User Manual Documentation 

3. The "New Folder" window will appear. 
New Folder Update x 

General Advance Default Access 

Document Profile 

General 

Folder Name 

Description 

Folder Type 

Normal 

Default eForm 

Sort Field 

Default 

Sort A-Z 

O 

4. Choose the "Document Profile", which defines what meta-data are stored in your 
document profile. For example, Marketing Event. 

New Folder Update x 

General Advance 

Document Profile 

Marketing Events 

5. Input the folder name "Events and Seminars". 

Folder Name 

Events and Seminars 

6. Input the description "Marketing events and seminars." This is an optional field; you may 
skip that if you do not need any description. 

Description 

Marketing events and seminar 

7. Click "Update" button to commit changes. 
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8. A new folder "Events and Seminars" is created. 

• Marketing 

> D Events and Seminars 

9. By default, the folder description is not show in the document list. To show the 
description field, select "Settings> Preference". Please contact your system administrator 
to proceed with this action. 

g e 
ash Tag Version By 

My Account 

My Shared Links to Guest 

My Reminder Record 

Preferences 

User and Group 

Document Framework 

Administrative 

All Workflow Processing Task(s) 

System Audit Log 

My Workflow Delegation 

Change Column View 

Settings 

, Reports 

» Logout 

10. In the Preference window, enable "Show Description" and update the setting. 

Preferences Update X 

Document List Folder Tree 

Number of documents display per page 

100 

Send document link 

Popup email client 

Show Description 

CO 
Show Created date 

Show Page Count 

Split at Name Column 
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II. Folder Type 

1. There are three types of folders: 

Folder Type Description 

Normal Electronic documents, by default the folder is in list view. 

Album Photos and images, by default the folder is in thumbnail view. 

eForm eForm, by default the folder is in list view. 

2. If eForm folder type is selected, you are required to select the default eForm template to 
use. 

New Folder Update x 

General Advance 

Document Profile 

Employee Profile 

Folder Name 

Employee Profile 

Description 

Folder Type 

EForm 

Default eForm 

Employee Profile.rft 

3. Under this folder type, you can create new eForm records by simply adding a new form 
from the "New" pull-down list in the folder. 

New Y T Upl 

Folder 
•••••••• • •• ¢ 

Ei erForm 
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4. Fill-in the eForm and then click "Save" button to commit changes. 

Note: You can try on the sample folder "Home\Samples\Human Resources\Employee 
Profile" 

Ill. Folder Naming by Rule 

1. Rule is the document auto naming sequence. You can select an auto naming rule for any 
documents upload to this folder. 

Edit Update x 

General Advance 

Rule 

Employee Profile Ref No. 

2. When a rule is applied, all document name upload to this folder will auto renamed 
according to the rule and sequence you have configured. 

-+ New V 7 Upload Index V View V Change Column View Recycle Bin @ 

□ - [Fite Name Staff No. Employee Full Position Title Department 
Name 

□ tr an . EP-02 HR240135 PETER CHAN Project Manager Information Technology 

□ { an . EP-03 HR240136 CARMEN WONG Human Resources Human Resources 

3. For more information, please refer to section "Rules and Sequence" in "A624002 ­ 
Antelope 6 Workspace Administration Manual". 

IV. Filter Owner 

1. Every user account, user group and functional group is assigned with specific access 
permission on the folder. 

New Folder Update x 

General Advance 

Rule 

Filter Owner 

O 
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2. If your login account does not have "Manage" rights on this folder, you can only see the 
documents which are created by yourself, which means the owner of the document is 
you. 

Permission Level 

Company Name Read Preview Modify ...... Manage 

® 19 Company Access Deny o 
® 19 Company Full Access 0 0 0 o 
® 19 Company Modify o o o 

Note: Permission Level can only be managed by your system administrator. 

3. If your login account is assigned the "Manage" rights on this folder, you can see all 
documents even the owner is not you. 

4. The following are some samples of different user accounts can see in a folder with "Filter 
Owner" turned on. 

User Account With "Manage" What user account see in the folder 
access permission 

Antelope Yes T File Name Size Version Version Date Version By 

al . EP-0042 13 KB 1.0 2024-09-01 14.51.24 Jennifer Tam 

a . EP-0043 13 KB 1.0 2024-09-0114:52:42 Antelope 

a . EP-0044 13 KB 1.0 2024-09-01 14.5256 Userl 

a . EP-0045 13 KB 1.0 2024-09-01 14.54.18 User2 

Jennifer Tam No T File Name Size Version Version Date Version By 

al . EP-0042 13 KB 1.0 2024-09-01 14.51.24 Jennifer Tam 

User1 No T File Name Size Version Version Date Version By 

al . EP-0044 13 KB 1.0 2024-09-01 14.52.56 Userl 

User2 No T File Name Size Version Version Date Version By 

a . EP-45 13 KB 1.0 2024-09-01 14.54.18 User2 
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V. Major and Minor Version 

1. When the folder is minor version enabled, all documents upload to this folder will start 
from version 0.1. 

Minor Version 

O 

2. Whenever there are content changes in the document, the version will increase by 0.1, 
until the document is published to another major version. 

3. If the folder minor version is disabled, all documents upload to this folder will start from 
version 1.0, 2.0, 3.0 and so on. 

4. For more information, please refer to Section N (VII). 

VI. Maximum Major Version/ Maximum Minor Version 

1. The maximum major or minor versions define the maximum number of version 
documents can store in the folder. 

Max. Major Version 

Max. Minor Version 

2. If the maximum major version is set to 3, which means the system will store only the 
latest three versions. When the fourth one is updated, the first one will be removed 
automatically, which is in a model of First-In First-Out (FIFO). 

Version History ff] x 

► File Name Version By Version Version Date 

@ G Non-disclosure agreement.docx Antelope 6.0 2024-09-0115:10:15 

@ &8 ~ t@ G Non-disclosure agreement.docx Antelope 5.6 2024-09-0115:10:07 

@ &9 ~ t@ G Non-disclosure agreement.docx Antelope 5.5 2024-09-0115:09:58 

@ &9 ~ ta G Non-disclosure agreement.docx Antelope 5.4 2024-09-0115:09:55 

@ &9 ~ ta G Non-disclosure agreement.docx Antelope 5.3 2024-09-0115:09:50 

@ &9 ~ ta ll Non-disclosure agreement.docx Antelope 5.2 2024-09-01 15.09:47 

@ &9 ~ ta G Non-disclosure agreement.docx Antelope 5.0 2024-09-0115:09:22 

@ &9 ~ ta G Non-disclosure agreement.docx Antelope 4.0 2024-09-01 15.08:47 

Note: In the above case, only the latest 3 major versions are retained (V 4,5,6), while the latest 5 minor 
versions are retained also (V5.2, 5.3, 5.4, 5.5, 5.6) 
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VII. Copy Index 

1. Folder supports profile indexing. To index a folder, select a folder from document list. 
1 

Edit Update x 

General Advance 

Rule 

Filter Owner 

Minor Version 

CO 
Max. Major Version 

Max. Minor Version 

Show Page Count 

Copy Index 

O 

2. Select "Index" menu from the tool bar, then select "Edit" option. 

Home > Samples > Agreements 

+ New V T Upload Index V View V Change Column View Recycle Bin e 

□ Edit Size Version Version Date 

Export 

rments EI st 2024-09-01 15:18.03 

□ Import 
tr . a gs 2024-09-01 15.18:24 

3. Input meta-data for the folder. 
0 - I File Name 

a 
EI a * 

tr 

Non-Disclosure Agreements 

Rental Agreements 

Size Version Version Date Hash Tag 

2024-09-01 15.21.34 #NDA 

2024-09-01 15.21.34 #Rental Agreement 

Subject Matter Agreement Type 

Non-Disclosure Agreement 

Property and Rental 

Property and Rental 
Purchase 
Recruitment Agency 
Non-Disclosure Agreement 

4. Click the blue save button from the toolbar. 
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s. If "Copy Index" is enabled, all new documents upload under this folder will inherit the 
folder index. 

Name v Keyword Search ­ Home > Samples > Agreements > Non-Disclosure Agreements ' 

+ New Upload Index View Change Column View Recycle Bin ­ [ pile Name Size Version Version Date Hash Tag 

e 

Subject Matter 

0to0(Page1) v 

Agreement Type 

Upload new document to this folder... 

= Name v Keyword Search ­ Home > Samples > Agreements > Non-Disclosure Agreements ' 

« q ' 0 @ 

+ New Upload Index View 

□
Eu 
□

[File Name 

Change Column View Recycle Bin O 

Size Version Version Date Hash Tag Subject Matter 

* - .. Non-disclosure agreement.docx 

? a Non-disclosure agreement.pdf 

85 KB 

76 KB 

0.1 2024-09-01 15.23.37 

0.1 2024-09-01 15.23.37 

e 1to2(Page1) v > 

Agreement Type 

Non-Disclosure Agreement 

Non-Disclosure Agreement 

All documents index field values are inherited from their parent folder. 
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VIII. Quota Schema 

1. Quota scheme is a control rule which limit the folder storage capacity or criteria with one 

of the following options: 

a. What document types are allowed to upload 
b. Maximum number of documents 

c. Maximum storage of documents 

Max. Minor Version 

Show Page Count 

Copy Index 

CO 
Quota Schema 

Not allow Video Files 

2. For more information, please refer to section "Quota Schema". 

@ @ Company 

@ Company 

Name 

Limit to 100Mb File Size 

Total Size Limit in KB 

10000 

Not allow Video Files 

Rules ] x 

File Extension Size Limit per File in 
KB 

avi 

.mpg 

] .mov 

] .mp# 

3. Once the quota limit is set, there will be a control on the document to upload. 
Name v Keyword Search 

Home > Samples > Agreements > Non-Disclosure Agreements 

+ New Upload Index View v Change Column View Recycle Bin [D 

□
□
□

20220629_123214000_i05.mp4 4.0MB The file size is exceed the 
single file size limit 

Version Version Date 

0.1 2024-09-01 15.23.37 

0.1 2024-09-01 15.23.37 
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IX. Edit Folder 

1. Select the folder you want to edit profile. Right-click to bring up the context menu, then 
select "More > Edit". 

> D Samples 

» share to external test 

» 7 re 
lj Reoyle Bin 

Advanced Search 

Share To 

Update Thumbnail 

More 

Cut 

Copy 

Workflow Applications 

System 

Delete 

Edit 

Follow 

Temporary Permission 

Permission 

2. The "Edit" window will appear. 

Edit Update x 

General Advance 

Document Profile 

General 

Folder Name 

Samples 

Description 

Folder Type 

Normal 

Default eForm 

Sort Field 

Default 

Sort A-Z 

O 

3. Click "Update" button to commit changes. 

X. Share Folder Link to Internal User 

1. To share a folder as hyperlink to internal user, select the folder you want to share, right­ 
click to bring up the context menu, then select "Share To > Internal". 
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>D Samples 
Share To Internal 

>D share to external tes1 
Update Thumbnail 

>D Test More 

1w Recycle Bin Cut 

Advanced Search Copy 

2. This will copy the share link to clipboard or pop-up the default email client. 
https://apac.antelopecloud.net/demo/main.aspx?sld=OGJHHNDFGHGIXXXXXXXXXXXXX 

3. The action preference can be configured by system administrator under "Setup> Setting 
> Preference> Send Document Link". 

Preferences Update x 

Document List Folder Tree 

Number of documents display per page 

100 

Send document link 

' Popup email client 
Copy to clipboard 

p 
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XI. Update Folder Thumbnail 

1. Select a folder you want to change thumbnail, right-click to bring up the context menu, 
select "Update Thumbnail". 

Home > Samples > Zoo Management 

+ New 1' Upload Index V View V Change Column View Recycle Bin O 

□ - T File Name Size Version Version Date Version By 

Eu tr . Elephant a es, s-3559 

□ Share To 
{ . Panda 3621 

□ Update Thumbnail 
tr . Penguin 36.15 

More □ tr . Zebra 36.27 
Cut 

Copy 

2. The Update Thumbnail window will appear. Browse for JPG file with recommend 
resolutions of 500 x 500 pixels, then click "Upload" button. 
. 1 

Update Thumbnail Upload x 

Browse 20 MB JPEG File Only (500 x 500px) 

File Name: X 

3. To view the folder thumbnail, from the document list tool bar, select View> Thumbnail. 
=o 

Chge Colom cycle in 

R 
0 f­ 0 
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XII. Delete Folder 

1. Select a folder you want to change thumbnail, right-click to bring up the context menu, 
select More> Delete. 

Home > Samples > Zoo Management 

New Upload Index View 

□ - [te Name 

E tr . Elephant 

□ r Panda 

[ l tr . Penguin 

□ tr . Zebra 

Change Column View Recyc le Bin 

Size Version Version Date Version By Hash Tag 

Share lo 
sea n s +-35.59 

i.3621 
Update Thumbnail 

More 

Cut 

Copy 

De lete 

Edit 

Follow 

Temporary Permission 

Permission 

2. A confirmation message will appear, click "Yes" button to confirm. 

G. Follow 
Follow is a feature which allows you to "monitor" a folder for new incoming documents and 
send alerts to users, trigger any workflows or Al Capture Service. 

I. Create New Follow 

1. To create a new Follow, select a folder, right click to bring out the context menu. Select 
More> Follow. 
v CJ Accounting 

> CJ Bill of Lading 

> CJ Inv' 
Share To 

> CJ Pur 
Update Thumbnail 

> CJ Agreer 
More 

> CJ Humar 
Cut 

> CJ IT Copy 

» Logistic ­ 
> CJ Marketing 

> CJ Office Admin 

Delete 

Edit 

Follow 

Temporary Permission 

Permission 
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2. The Follow window will appear. Click the "Add" icon. 

Follow 

Created Date Type 

@ 

3. Select the following options. This will send email to the document owner when a new 
document is added to the folder. Click "Update" button to save. 

New Update x 

This happen when 

a new document is added 

right after .. 

when it just happen 

Action 

Email Alert Owner 

4. A new Follow rule is added. 
Follow ] x 

Created Date Type Advance Setting Template Members 

2024.-08-27 a new document is added Ema il Alert Owner Antelope 

5. From now on, when you add a new document to the folder, the document owner will 
receive an email notification. 
Subscription: A new document is added Eternal Ibo 

workflow@system.com via sendgrid.net 
tome 

Subscription News 

New document(s) are uploaded under the folder Invoices 

Document List: 

This is a Test docs 

Please click on the document link to access the content. 

This mes sage was sent to you beca use you have an Antelope account. 
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II. Follow Events 

There are different events which can trigger a Follow action. The following table is a full 
description on what events you can configure for folder monitoring: 

This Happens When ... 
Options Description 
A new document is added When a new document is added to the folder. 

A document is updated When a document is updated with newer version, or the 
document index is updated. 

A document is commented When user comment on a document. 

Advanced Works with below option "some index field(s) values are 
matched" only. 

Right After ... 
Options Description 
some index field(s) values are Refer to Section IV. 
matched 

When it just happens Right after user complete the action, for examples, add 
document, update index, update version etc. 

The document is modified for 3 After the document is modified for three years (e.g. update index, 
years. update version) 

The document is created for 5 After the document is uploaded for 5 years. 
years. 

Action 
Options Description 
Add to Group List Add to "Notification" webpart. You are required to select which 

user group(s) to notify. 

Add to My List Add to "Notification" webpart. 

Add to User List Add to "Notification" webpart. You are required to select which 
user account(s) to notify. 

Email Alert Group Send email notification to recipient(s). You are required to select 
which user group(s) to notify. 

Email Alert Owner Send email notification to document owner. 

Email Alert User Send email notification to recipient(s). You are required to select 
which user account(s) to notify. 

Start Workflow - Al Capture Document uploaded to the folder will auto run Al Capture. 
Service 

Start Workflow - Expenses Auto start the Expense Claim workflow when a new document is 
Claim.rwt added to the folder. The document will become an attachment to 

the workflow. 
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Ill. Tigger by Index Field 

1. This option is to trigger a Follow action when a document matches a certain criterion, for 
example, when the index field of a contract "Contract Expiry Date" reaches a certain 
date, or 30 days before the expiry date. 

2. Select "Advance" and "some index field(s) values are matched". 
New Update x 

This happen when 

Advance 

right after ... 

some index field(s) values are matched 

Action 

Email Alert Owner 

3. The index field(s) options will appear. 
New Update x 

This happen when 

Advance 

right after ... 

some index field(s) values are matched 

Action 

Email Alert Owner 

Mail Template 

SubscriptionCommentEmail 

Index Field 

Subject Matter 

Field Type 

Numeric 

Operator 

Index value 
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4. Here is an example, if you want the system to notify the document owner when the 
contract date reaches 30 days before "2025-10-15", then you should set the Index Value 
"Now() - 30D" 
Home> Samples > Agreements > Real Estate Purchase Agreementpdf @ x 

? Edit Relation Share To Compare Index Reminder Redaction AI Genie 

Index List [] 

File Name Real Estate Purchase Agreen 

Size 227 KB 

Version 1.0 

Version Date 2024-06-28 13.28.14 

Hash Tag 

Subject Matter Real Estate Purchase Agreer 

Agreement Type Property and Rental 

Date of Agreement 2024-04.-04 

Contract Expiry Date 2025-10-15 

Real Estate Purchase Agreement for New York 

THIS SALES AGREEMENT (the "Agreement") dated this 4th day of APRIL,2024 (the 

"Execution Date") 

BETWEEN: 

Peter Chan 
(the "Seller") 

-AND­ 

Sophia Chan 
(the "Buyer") 

Ver 1.0/by Brandon 

OF THE FIRST PART 

OF THE SECOND PART 

BACKGROUND 
The Seller wishes to sell a certain completed home and the Buyer wishes to purchase this completed 

Index Field 

Contract Expiry Date 

Field Type 

Datetime 

Operator 

Index value 

Now0 - 30] 
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H. Permission 

I. Assign Permission 

1. To assign a permission, select the folder (or document), right click to bring up the context 

menu, select More> Permission. 

D Agreements Share To 

D Human Resource! Update Thumbnail 

D IT More 

D Logistic Cut 

c Management Copy 

D Marketing 
D Office Admin 

ed earch 

Delete 

Edit 

Follow 

Temporary Permission 

Permission 

2. The Permission window will appear. 
Permission ff] x 

User or Group Functional Name Permission Level 

LI Administration Group ($Administrators) 

System Service Group (System Services) 

I Accounting Department (Accounting) 

Company\Full Access 

Company\Full Access 

Company\Read Only 

Agreements 

Permission inherit from parent folder 
rr 

3. Click the first empty row position to bring up the "Select user or group" window. 

Select user or group x 

Users V Name 

o Antelope - admin 

o Userl - userl 

o User2 E user2 

e User3 E user3 
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4. Select the user account to add, for example "User1". 
Permission ff] x 

User or Group Functional Name Permission Level 

II User1 

8r tu Administration Group ($Administrators) Company\Full Access 

8t Lu System Service Group (System Services) Company\Full Access 

8t tu Accounting Department (Accounting) Company\Read Only 

5. Select the "Permission Level", for example " Modify". 
Permission ff] x 

User or Group Functional Name Permission Level 

II Userl Company\Modify 

8 Lu Administration Group ($Administrators) Company\Access Deny I Company\Full Access 

8t Lu System Service Group (System Services) Company\Modify 
Company\Read Only 

8 Lu Accounting Department (Accounting) Company\Share 
Company\Workflow Manager 

6. Click the blue add icon to commit changes. 
Permission ] x 

User or Group Functional Name Permission Level 

a 8t 1 User1 (user1) Company\Modify 

8r tu Administration Group ($Administrators) Company\Full Access 

8r u System Service Group (SSystem Services) Company\Full Access 

8r Lu Accounting Department (Accounting) Company\Read Only 

7. Instead of user account, you can add User Group by selecting the User Group option. 

4 Administration Group e $Administrators 

1 Accounting Department e Accounting 

4 Human Resources Department e Human Resources 
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II. Break Inherit 

1. All folder permissions are inherited from its parent folder. If you want to break the 
inheritance, click the blue "Break Inherit" button at the bottom of the Permission 
window. 

Break inherit 

2. A confirmation message will appear, click Confirm button. 

3. All permissions are now effective as standalone and will not inherit from its parent folder. 
You can remove any effective permission. 

Permission ff] x 

User or Group Functional Name Permission Level 

gr I Administration Group (Administrators) 

@ 8t LI System Service Group ($System Services) 

8t I Accounting Department (Accounting) 

@ 18r I User1 (user1) 

Company\Full Access 

Company\Full Access 

Company\Read Only 

Company\Modify 

Ill. Restore Inherit 

1. To restore the folder to inherit from its parent folder, click the "Restore Inherit" button. 

Restore inherit 

2. The folder will inherit its parent folder's original permission. 
Permission ] x 

User or Group Functional Name Permission Level 

8r tu Administration Group ($Administrators) Company\Full Access 

8t tu System Service Group (System Services) Company\Full Access 

8r u Accounting Department (Accounting) Company\Read Only 

a 8 tu Administration Group ($Administrators) Company\Full Access 

@ 8t Lu System Service Group (System Services) Company\Full Access 

a 8t u Accounting Department (Accounting) Company\Read Only 

a t8 1 User1 (user1) Company\Modify 
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3. You should remove those existing permission which contradict or duplicate with the 
original one. 

Permission f] x 

User or Group Functional Name Permission Level 

8r tu Administration Group ($Administrators) Company\Full Access 

8r u System Service Group (SSystem Services) Company\Full Access 

t8 Lu Accounting Department (Accounting) Company\Read Only 

@ 8t u Administration Group ($Administrators) Company\Full Access 

Iii! 8t Lu System Service Group (SSystem Services) Company\Full Access 

a 8 tu Accounting Department (Accounting) Company\Read Only 

@ 8t 1 User1 (user1) Company\Modify 

I. Temporary Permission 

I. Assign Temporary Permission 

1. You can assign a temporary permission for any user account to access the current folder. 
Temporary Permission ff] x 

Grant To Div./Dept. From Date To Date Permission Level 

2. Select the user account, date range and permission level. 
Temporary Permission ff] x 

Grant To 

Ill Userl 
Div./Dept. From Date To Date Permission Level 

2024-08-28 2024-08-30 Company\Read Only 

3. Click the blue add icon to commit changes. 
Temporary Permission ff] x 

Grant To Div./Dept. From Date To Date Permission Level 

@ user1 2024-08-28 2024-08-30 Company\Read Only 
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J. Recycle Bin 
I. Recycle Bin View 

1. The view the recycle bin, click the "Recycle Bin" icon from the folder tree. 
Name v l Keywor d Search 

Recycle Bin 

Folders e 1to7(Page1) v 

[ Quid Access Name 

[ My Check out 

[a) My Favorites 

{] My Clipboard 

(O) Rec ent Ope n Doc uments 

[] Personal Folder 

• 7Home 

» [_] Personal Folders 

» [] Pojets 
» ] samples 

[ij Rey<le Bin 

D BillofLading 

, INV24003 pdf 

, P8268491 pdf 

es, P8268492 pdf 

, C00000A. t 

, PB268493 pdf 

id nss» tetae 

Size Version Owner / Display Delete By Modified Date Folder Path 
Name 

1.0 Antelope Antelope 2024-08-28 09.22.25 Home\Sampl 

140 KB 1.0 Antelope Antelope 2024-08-28 09.22.25 Home\Sample 

65 KB 1.0 Antelope Antelope 2024-08-28 09.22.25 Home\Sample 

503 KB 2.0 Antelope Antelope 2024-08-28 09.22.25 Home\Sampl 

KB 1.0 User2 Antelope 2024-08-28 09.22.25 Home\Sampl 

65 KB 1.0 User2 Antelope 2024-08-28 09.22.25 Home\Sampl 

13 KB 1.0 Antelope Antelope 2024-08-27 173721 Home\Sampl 

2. To purge all documents, click the recycle bin icon from the top of the list. 

Name Size Version 

D Bill of Lading 

, INV24003.pdf 

c, PB268491.pdf 

, PB268492.pdf 

140 KB 

65 KB 

503 KB 

3. To purge selected document, select those documents and click "Purge Document" from 
the context menu. 

Name Size Version 

D Bill of Lading 

, NV24003.pdf 

, PB268491.pdf 

, PB268492.pdf 

n, C00000004.txt 

, PB268493.pdf 

d res » tea 
Restore 

Purge Document 

140 KB 

65 KB 

503 KB 

0 KB 

55 KB 

13 KB 
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4. To restore the deleted documents, click "Restore" from the context menu. However, if 
the documents' parent folder is already removed, you cannot restore any content. 

Name Size Version 

0 Bill of Lading 

, NV24003.pdf 

, PB268491.pdf 

, PB268492.pdf 

lll:ill O(00000004.txt 

, PB268493.pdf 

d r»is s» tea 

140 KB 

Restore 

Purge Document 

0 KB 

65 KB 

13 KB 

II. Folder Recycle Bin 

1. To view what document(s) are deleted in a specific folder, click "Recycle Bin" button from 
the document list. 

Name v Keyword Search 

Home > Samples > Accounting >» Invoices 

Folders + New Upload Index View Change Column View Recyc le Bin 

Quik Access 

[a My Check out 

[) My Favorites 

{] My Clipboard 

(O) Recent Open Documents 

3 Personal Folder 
- 2 Home 

» [_] Personal Folders 

• Projects 
» g] Pr6jet Alpha 

• ) samples 

[] Accounting 

» 1voices 

» Purchase orders 

» ] Agreements 

□ - [le Name Sire Version Version Date Version By 

□ tr Ea . INV24001 pdf 139 KB 10 2024-06-28 12.51.07 Antelope 

tr En . INV2400 2.pdf 140 KB 10 2024-06-28 12.51.08 Antelope 

□ r » . INV24003.pdf 140 KB 10 2024-08-20 11.54.16 Antelope 

e 
Hash Tag 

n123 

1to3(Page1) » 

Invoice No. 

2. This will show all document(s) which are deleted within the selected folder. 
Keyword Search 

Home > Samples > Accounting > Invoices 

Folders 

3 Personal Folder 
• 2 Home 

» [_) Personal Folders 

] Projects 

» g Pojet Alpha 

• samples 

• ] A«counting 

tvoices 

» ) Purchase orders 
» [] Agreements 

Name Sire Version 

e 1to1 (Page1) » 

Owner / Display Delete By Modified Date 
Name 

Folder Path 

d n« s» retake 13 KB 1.0 Antelope Antelope 2024-08-27 17.37.21 Home\Sample 
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K. Hyperlink 

I. Create New Hyperlink 

1. To create a new link, select a folder. 

2. Select "New" context menu, then "New Hyperlink". 

+ New V 1' Upl 

Folder 

t New Folder Tree 

b 
New Calendar EI 

~ 
New Project ~ ~ 

& New Hyperlink 

l±l From Template 

3. The New Hyperlink window will appear. Input the "Name" and "URL Address". 

New Hyperhnk Create x 

URL Name 

Google 

URL Address 

https://www.google. com] 

4. Click "Create" button to save. 
+ New Upload Index v View v Change Column View Recycle Bin 

□
Eu 

l File Name 

{ @0 • Google 

Size Version Version Date 

1.0 2024-08-28 21.58.22 
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II. Edit Hyperlink 

1. To edit a hyperlink, select "Edit" from the context menu. 

T File Name 

tr . Google 

Size Version Version Date 

More 
1.0 2024-08-28 21:58:22 

Edit 

Delete 

2. Edit either the "Name" or "URL Address", then click "Update" button to commit changes. 

Ill. Delete Hyperlink 

1. To delete a hyperlink, select "Delete" from the context menu. 

l File Name 

tr 0 . Google 
More 

Size Version Version Date 

---4-08-28 21:58.22 
Edit 

Delete 

2. A pop-up message will ask for confirmation. Click "OK" to commit. 

L. Calendar 

I. Create New Calendar 

1. To create a new calendar, select a folder. 

2. Select "New" context menu, then "New Calendar". 

+ New.YI Upl 

Folder 

t; New Folder Tree 
b 

New Calendar a 

~ New Project 

9 New Hyperlink 

l±l From Template 
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3. The New Calendar window will appear. Input the "Name". 
New Calendar Create x 

Calendar Name 

Sample 

4. Click "Create" button to save. 
+ New V T Upload Index V View V Change Column View Recycle Bin 

□ f File Name Size Version Version Date 

□ t D . Sample 1.0 2024-08-28 22.28.26 
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II. Create Activity 

1. Click the calendar record to open the calendar view. 
DAY 

Sunday 

« EEEa 
Monday Tuesday 

August 2024 

Wednesday Thursday Friday 

TODAY 

Saturday 
28 29 30 31 01 02 03 

04 OS 06 07 08 09 10 

11 12 13 14 15 16 17 

2. Double click one of the dates, the New Event window will appear. Fill-in the description 
and location, select the participants and date of the activity. 

00:00 - 00:00 NEW EVENT 

Type Task 

Description New event 

Assign To admin 

Status Active 

Work 

Complete 
Ratio 

E Full day oo.oo . 30 July . 2024 " 

oo.oo . 31 v July . 2024 ­ 
EI 
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3. Click "Save" button to commit changes. 
DAY EE August 2024 TODAY 

Sunday Monday 
28 29 

Tuesday 
30 

• 12:00 Project Mee. 

04 OS 06 

Wednesday 
31 

07 

Thursday 
01 

08 

Friday 
02 

09 

Saturday 
03 

10 

Ill. Edit Activity 

1. To edit an existing activity, double click the activity record. 

2. Modify the activity and click "Save" button to commit changes. 
12 00- 13.00 PROJECT MEETING 

Type Activity 

Description Project Meeting 

Participants admin 

admin 9 

Location Boardroom A 

0 Full day 12oo . 30 July . 2024 ­ 
1oo . 30 July . 2024 " 

DELETE CANCEL EE 
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M. Document List 

I. Document List and Thumbnail View 

1. The document list shows the name, properties and index fields. 

2. To change into thumbnail view, from the document list tool bar, click View> Thumbnail. 

+ New V T Upload Index V View V Change Column View Recycle Bin @ 

□ l File Nar list view rsion Version Date Version By 

Thumbnail 

□ t » . INV24004.pdt 139 KB 1.0 2024-08-31 12.10.28 Antelope 

□ tr » . INV24005.pdf 139 KB 1.0 2024-08-31 12.10.53 Antelope 

3. The documents are shown in thumbnail. 

4. To change back to document list view, from the document list toolbar, click View> List 
View. 
+ New T Upload Index V View V Change Column View Recycle Bin @ 

□ l File Nar List view rsion Version Date Version By 

Thumbnail 

□ tr » . INV24004.pdr 139 KB 1.0 2024-08-31 12.10.28 Antelope 

□ t » . INV24005.pdf 139 KB 1.0 2024-08-31 12.10.53 Antelope 

II. Column Filter 

1. Apart from document full-text search and advanced search, you can also perform a quick 
searching using column filter. 

2. From the document list, click the icon. 

+ New v 7 Upload 

ti­ 
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3. The column filter will appear. 
-+ New V 7 Upload Index v View Change Column View Recycle Bin 8 

□ Y [ File Name Size Version Version Date Version By Hash Tag 

C- L L , 
□ * » . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope 

□ * b . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

□ * » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

4. Input the text which appears in the below document grid which you want to filter out. 
+ New V T Upload Index V View V Change Column View Recycle Bin !ID 

□ Y f File Name Size Version Version Date Version By 

f [24 L 
□ tr » . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope 

□ tr EE» . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

□ tr Ea . INV24003.pdf 140 KB LO 2024-08-31 12.32.14 Antelope 

5. The following data type cannot be searched by column filter: Hashtag, Details Line Items, 
Date Range (e.g. 2024-08-12 to 2024-08-30}. 

Ill. Export List 

1. You can export the document list into .xlsx format. 

2. From the document list tool bar, click Index> Export. 
+ New V T Upload Index V View Change Column View Recycle Bin @ 

□ Export Size Version Version Date Version By 

□ tr EE» 
Import 156 KB 1.0 2024-08-31 12.32.14 Antelope 

□ t » . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

□ t » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

3. The document list is exported as "export.xlsx" 

ID File Name Sze Version Version Date Version By Hash Tag Invoice No. Invoice Date PO No. Due Date Supplier Name Total Amount Line Items 

hr7 INV2400 L.pdf 156 KB I.o 2024-08-31 12:32:14 Antelope .oooo Details 

rs INV24002.pdf 140 KB 1.o 2024-08-31 12:32:14 Antelope .ooo0 Details 

rs INV2400 3.pdf 140 KB 1.o 2024-08-31 12:32:14 Antelope • oooo Details 

Pro INV2400A .pdf 139 KB 1.o 2024-08-31 12:32:15 Antelope 6.ooo0 Details 

hrs INV2400 5.pdf 139 KB 1.o 2024-08-31 12:32:15 Antelope 6.ooo0 Details 

Pao INV24006.pdf 139 KB 1.o 2024-08-31 12:32:15 Antelope 6.ooo0 Details 

P73 INV24007.pdf 140 KB .o 2024-08-31 12:32:15 Antelope 6.ooo0 Details 

Pu1 INV24008.pdf 139 KB .o 2024-08-31 12:32:15 Antelope 6.oooo Deta ils 

Pu2 INV24009.pdf 139 KB .o 2024-08-31 12:32:15 Antelope 6.oooo Details 

44 INV24010.pdf 138 KB .o 2024-08-31 12:32:16 Antelope • oooo Details 

P7us INV24011.pdf 138 KB I.o 2024-08-31 12:32:16 Antelope • o000 Details 
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IV. Import List 

1. You can modify the "export.xlsx" and import to the document list for purpose of batch 

indexing. 

2. Modify the data you wish to import, remember when you modify the cell value, you 

must follow the data type. For example, you cannot input numeric value in "Date" type, 

or input a date in "Numeric" type. 

ID File Name Sze Version Version Date Version By Hash Tag Invoice No. Invoice Date PO No. Due Date Supplier Name Total Amount Line Items 

2r7 INV24001.pdf 156 KB .o 2024-08-31 12:32:14 Antelope ABC INV2401 12/8/2024 PO12345 11/9/2024 ABC Com pany 1JS60 Details 

rs INV2400 2.pdf 140 KB .o 2024-08-31 12:32:14 Antelope DEF INV2 400 2 13/8/2024 PO12346 12/9/2024 DEF Com pany 12304 Details 

2rs INV2 400 3.pdf 140 KB 1.o 2024-08-31 12:32:14 Antelope • ooo0 Details 

r9 INV24004A .pdf 139 KB 1.o 2024-08-31 12:32:15 Antelope • oooo Details 

2rs INV2400 5.pdf 139 KB .o 2024-08-31 12:32:15 Antelope • ooo0 Deta ils 

740 INV24006. pdf 139 KB .o 2024-08-31 12:32:15 Antelope • ooo0 Deta ils 

743 INV2 400 7.pdf 140 KB 1.o 2024-08-31 12:32:15 Antelope • oooo Details 

3. From the document list tool bar, select Index> Import. 

+ New V T Upload Index I View V Change Column View Recycle Bin O 

□ Export Size Version Version Date Version By 

□ tr » Import 156 KB 1.0 2024-08-31 12.32.14 Antelope 

□ { EE» . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

4. The document list is indexed automatically. 
New V Upload Index View Change Column View Recycle Bin h 

□ T File Name Size Version Version Date Version By Hash Tag Invoice No. Invoice Date PO No. 

□ tr » . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope #ABC INV24001 2024-08-12 PO12345 

□ tr » . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope #DEF INV24002 2024-08-13 PO12346 

□ tr » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

□ tr » . INV24004.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

V. Change Column View 

1. You can change the sequence of column or hide any column of the specific folder by 

"Change Column View". From the document list toolbar, click the "Change Column View" 
button. 

+ New v T Upload Index v View V Change Column View Recycle Bin @ 

□ T File Name Size Version Version Date Version By Hash Tag Invoice No. 

□ tr E» . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope #ABC INV24001 

□ tr E» . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope #DEF INV24002 

□ tr » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

2. Select those columns on the right-hand side that you don't want to display in document 

list, and click the < icon. 
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Change Column View Reset Save Xx 

Select a Document Profile or Webpart: 

Document Profile List View - Invoices 

Available Columns: Selected Columns: 

Column Name 

Hash Tag 

Line Items 

Column Name 

File Name 

Size 

Version 

Version Date 

Version By 

Invoice No. 

Invoice Date 

PO No. 

> I Supplier Name 

Due Date 

Total Amount 

3. Drag and drop the column up and down to re-order their position. 
Invoice No. 

Invoice Date 

Supplier Name 

PO No. 

Due Date 

Total Amount 

4. Click the blue "Save" button to commit changes. 

5. The document list columns will re-order for the selected folder of your own user account 
according to your setting. 

-4 New V 7 Upload Index V View Change Column View Recycle Bin 

□ [ite Name Size Version Version Date Version By 

□ tr an . INV24001.pdf 156 KB 1.0 2024-08-31 1232.14 Antelope 

[ l * Ea . INV24002.pdf 140 KB 10 2024-08-31 12.32.14 Antelope 

□ * an . INV24003.pdf 140 KB 10 2024-08-31 12.32.14 Antelope 

□ tr » . INV24004.pdf 139 KB 1.0 2024-08-31 1232.15 Antelope 

□ tr » . INV24005.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

Invoice No. 

INV24001 

INV24002 

Invoice Date Supplier Name PO No. 

2024-08-12 ABC Company P12345 

2024-08-13 DEF Company P12346 

6. If you want to reset your adjustment to factory setting, click the blue "Reset" button. 

Reset Save x 

7. Pay attention that since you have customized the folder display setting, in case your 
system administrator has added a new index field, your folder document list will not 
reflect this new setting until you make another "Reset" or "Configuration" of your 
column view. 
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Change Column View Reset Xx 

Select a Document Profile or Webpart: 

Document Profile List View - Invoices 

Available Columns: Selected Columns: 

Column Name Column Name 

Hash Tag 

Line Items 

New Field 

File Name 

Size 

Version 

Version Date 

Version By 

Invoice No. 

Invoice Date 

Supplier Name 

PO No. 

Due Date 

Total Amount 

N. Document 
I. Upload Document 

1. To upload a document, drag and drop the file(s) from your desktop to the document list. 
+ New 7 Upload Index v View v Change Column View Recycle Bin [E 

□
□
□
□
□
□
□
□
□
□
□
□
□
□

329513.pdf 100% of 0.1MB Cancel 

329514.pdf 100% of 0.1MB Cancel 

329515.pdf Cancel 

329516.pdf Cancel 

0 329517.pdf Cancel 

329518.pdf Cancel 

329519.pdf Cancel 

329520.pdf Cancel 

Upload Completed: 4 of 12 Files 

aa - INV24010.pdf 138 KB 

ta - INV24011.pdf 138 KB 

te Version By 

13:04:36 Antelope 

13:04:36 Antelope 

12:32:14 Antelope 

12:32:14 Antelope 

12.32.14 Antelope 

12:32:15 Antelope 

12:32:15 Antelope 

12:32:15 Antelope 

12:32:15 Antelope 

12:32:15 Antelope 

Cancel Al 12:32:15 Antelope 

1.0 2024-08-31 12.32.16 Antelope 

1.0 2024-08-31 12.32.16 Antelope 

Invoice No. 

INV24001 

INV24002 

2. The upper limit of upload size per document is 2.0GB. 

3. In case something wrong during the upload process, please make sure your source 
documents are not being locked by other applications. If the situation keeps existing, 
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please contact your system administrator or service provider. 
+ New V T Upload Index View Change Column View Recycle Bin @ 

□ - te Version By 
329510.pdf 0.1MB No access for the object 

329511.pdf 0.1MB No access for the object 

329512.pdf 0.1MB No access for the object 

329513.pdf 0.1MB No access for the object 

329514.pdf 0.1MB No access for the object 

329515.pdf 0.1MB No access for the object 

329516.pdf 0.1MB No access for the object 

Upload Completed: 0 of 7 Files Close 

II. Preview Document 

1. To preview a document, click the document name. 
+ New V 1' Upload Index View V Change Column View Recycle Bin 8 

□ T File Name Size Version Version Date Version By 

□ t a» . INV24001.pdf 156 KB 1.0 2024-08-3112:32:14 Antelope 

□ tr Ea» . INV24002.pdf 140 KB 1.0 2024-08-3112:32:14 Antelope 

□ tr an . INV24003.pdf 140 KB 1.0 2024-08-3112:32:14 Antelope 

□ rt Ea» . INV24004.pdf 139 KB 1.0 2024-08-3112:32:15 Antelope 

□ t » . INV24005.pdf 139 KB 1.0 2024-08-3112:32:15 Antelope 

Invoice No. 

INV24001 

INV24002 

2. Click Preview button. 

INV24001.pdf x 

EE Check Out & Download Download 
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3. The document viewer will pop-up for previewing. 
- Home>» Samples > Accounting» lmvoices > INV24001 pdf > e . 
tr Edit Rela tion Share To Compare lnde Rem inder Redact ion AI Genie 

[) ee 234 e @ "' i Ver 10/by Antelope - Q cl' ® d 

3sarptecor INVOICE 

BILL TO 
ABC COMPANY LIMITED Invoice No. INV24001 
Flat A, I0/F, SampleCorp Innovation Tower, Invoice Date 10 June 2024 
Causeway Bay, PO No. PO123016 
Hong Kong Due Date: 10 July 2024 

NO. PARTICULARS QTY (PCS) UNIT PRICE DISCOUNT% AMOUNT I 
I Product Item A 2 J00.00 0.00 200.00 I 

2 Product Item B I 100.00 0.00 100.00 

I 

4. To show the index field column, click the hamburger icon = from the top left-hand side. 
Home> Samples > Accounting> Invoice> INV24001df x 
Edit Relation Share.lo Compare Index Reminder Reda ction AI Genie 

File Name INV2 400 1 pdf 

Sae 156 KB 

3saplecor INVOICE 

PO No PO12345 

2024-09-11 

BILL TO 

ABC COMPANY LIMITED 
Flat A, I0F, SampleCorp Innovation Tower, 
Causeway Bay, 
Hong Kong 

Invoice No. 
Invoice Date 
PO No 
Due Date: 

INV24001 
Io Jane 2024 
PO123016 
I0 July 2024 

fotat Amou nt 13560 0000 

Line htems Details 

No PARTICULARS TY(PCS) UNIT PRICE DISCOUNT% AMOUNT 

I Product Item A 

Product Item B 

100 . 00 0.00 

100 .00 0.00 

200 .00 

100 .00 

5. The following document type can be previewed on screen by default: 

Document Type Document Extension 

Word Processing DOC, DOCX, RTF, TXT 

PowerPoint PPT, PPTX 

Excel XLS,XLSX 

Image BMP, GIF, JPG, PNG, TIF, TIFF, PSD 

Video MP4 

6. Note: The maximum size for document preview is 20 Mb. 

Page 71 



Antelope 6 Workspace User Manual Documentation 

Ill. Index Field 

1. To index a document, from the document viewer tool bar, select Index> Edit. 

= Home > Samples > Accounting > Invoices > INV24001.pdf 

Edit Relation Share To Compare Reminder Redaction Al Genie 

Index List Edit 

File Name INV24001.pdf 

Size 156 KB 

Version 1.0 

Version Date 2024-08-31 12.32.14 

Version By Antelope 

@ 

2. Edit the document index. 
Index List EI X 

File Name INV24001.pdf 

Size 156 KB 

Version 1.0 

Version Date 2024-08-31 12.32.14 

Version By Antelope 

Invoice No. INV24001 

Invoice Date 2024-08-12 

Supplier Name I ABC Company 

PO No. PO12345 

Due Date 2024-09-11 

Total Amount 13560.0000 

Line Items Details 

3. For line item, click the "Details" hyperlink to pop-up the line-item window. 
value Detail f] x 

Item No. Item Description 

2 

@ 1 

Product Item B 

Product Item A 

Qty Unit Price IGST Total Amount 

2 

100 

100 

0 

0 

100 

200 

4. Click the blue save button II to commit changes. 

5. You can also index a batch of documents by selecting Index> Edit from the document list 
tool bar. 
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-+ New T Upload Index View V Change Column View Recycle Bin 8 e 1 to 11 (Page 1) V > 

□ Edit Size Version Version Date Version By Invoice No. Invoice Date Supplier Name 

E { E» 
Export 156 KB 1.0 2024-08-31 12.32.14 Antelope INV24001 2024-08-12 ABC Company 

E tr E» Import 140 KB 1.0 2024-08-31 12.32.14 Antelope INV24002 2024-08-13 DEF Company 

Eu { » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

E { b . INV24004.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

Eu tr E» . INV24005.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

□ { » . INV24006.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

□ { En . INV24007.pdf 140 KB 1.0 2024-08-31 12.32.15 Antelope 

□ tr » . INV2400B.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

6. Edit the index and click the blue save button to commit changes. 
-New 7 Upload Index View Change Column View Recycle Bin Ea e < 1to 11 (Page 1) V > 

□ T File Name Size Version Version Date Version By Invoice No. Invoice Date Supplier Name 

□ 8 { » . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope INV24001 2024-08-12 ABC Company 

□ 8 {r En . INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope INV24002 2024-08-13 DEF Company 

Eu 8 tr » . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope [iwv24oo3 

□ d r » . INV24004.pdf 139 KB 1.0 2024-08-31 1232.15 Antelope 

□ i tr » . INV24005.pdf 139 KB 1.0 2024-0B-3112:32:15 Antelope 

□ i tr » . INV24006.pdf 139 KB 1.0 2024-08-31 12.32.15 Antelope 

□ {r » . INV24007.pdf 140 KB 1.0 2024-08-31 12.32.15 Antelope 

IV. Check-Out and Edit 

1. To check-out a document for annotation, from the document viewer toolbar, select Edit> 
Check Out & Edit. 
E Home > Samples > Accounting > Invoices > INV24001.pdf 

$? Relation Share To Compare Index Reminder Redaction AI Genie 

Inde~ Check Out & Edit v»­ 
File N Check Out & Download 01.pdf 

Size 
Download 

Versio 

Versio Mark Final Version 8-31 1232.14 

Versio Add to My Clipboard e 

Invoice No. INV24001 

Invoice Date 2024-08-12 

Supplier Name ABC Company 

PO No. PO12345 

Due Date 2024-09-11 

Total Amount 13560.0000 

3samptecer 
BILL TO 

ABC COMPANY LIMITED 
Flat A, 10/F, SampleCorp Innovation Tower, 
Causeway Bay, 
Hong Kong 

2. The document is checked out and prevent other users from editing. A lock icon will 
appear beside the document and will show who has checked out the document. 
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+ New V T Upload Index V View V Change Column View Recycle Bin 8 

□ l File Name Size Version Version Date Version By 

□ 8 tr » . INV24001.pdf 156 KB 1.0 2024-08-31 12.32.14 Antelope 

□ ETTI­ INV24002.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

□ t EE» . INV24003.pdf 140 KB 1.0 2024-08-31 12.32.14 Antelope 

3. Upon check out, the annotation tool bar will be enabled. 
Home > Samples > Accounting > Invoices > INV2400 1pdf @ X 

? Edit Relation Share To Compare Index Reminder Redaction AI Genie 

[] 

3sarplecor 

View An te SI 

BILL TO 

ABC COMPANY LIMITED 
Flat A, I0/F, SampleCorp lnnovation Tower, 
Causeway Bay, 
Hong Kong 

R t Insert Edit Fill and Sign 

Invoice No. 
lnvoice Date 
PO No. 
Due Date: 

INVOICE 

INV24001 
I0 June 2024 
PO123016 
I0" July 2024 

V. Document Viewer Annotation 

1. All electronic documents upload to Antelope 6 will have a PDF file rendered for online 
preview and annotation purpose. The annotation tool contains the following features 
that you can perform on the document preview version. 

a. Annotate 

Icon Feature Description / Sample 

El Highlight BILL TO 

ABC COMPANY LIMITED 
- 
A Underline BILL TO 

- ABC COMPANY LIMITED 
- 
A Strike Out BILL TO 
7 

ABC COMPANY LIMITED 
- 
A Squiggly BILL TO - ABG GOMPANYU-DUE 
- Note I - 

Comments (1) 

3sarptecor Sort; Position V 

Pa 1 

[! Antelope:f ! G 
II 

]This is my Comment I BILLTO I 
ABC CO PANY LIMITED eE 
Flat A, I 0/F, SampleCorp Innovation Tower, 
Causeway Bay, 
Hong Kong 
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- 
T Free Text o {sent tgt here} @ 

ABC COMPANY LIMITED 
- 
□ Rectangle ere ,J 

ABC COMPANY LIMITED 

2 Free Hand BILL TO 

Ac covvnunr@» 

9 Free Hand Highlight BILL TO 

ABC COMPANY LIMITED 

cc Redo/ Undo 
- - o Eraser Erase the annotation objects 

b. Shapes 

Icon Feature Description / Sample 

2 Free Hand BILL TO 

Ac coves(rep 

9 Free Hand Highlight BILL TO 

ABC COMPANY LIMITED 

□ Rectangle we J ABC COMPANY LIMITED 
- ..» 0 Ellipse 

LIMITED 

0 Polygon ~BILL TO 
ABC COMPANY LIMITED] 

0 Cloud 

B"LTO c:J 
ABC COMPANY LIMITED 
Flat A, 10/F, SampleCorp Innovation Tower, 

t Line BILL TO 

ABC COMPANY LIMITED 

d Polyline eaa 
ABC COMPANY LIMITED 

? Arrow BILL TO e@ 
ABC COMPANY LIMITED 

c. Redact 

Icon Feature Description / Sample 

Mark for Redaction BILL TO 

Marked as Hidden 

Redact entire page All redaction will be marked permenant and saved as 
another version. 

Redaction Panel 
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d. Insert 

Icon Feature Description / Sample 
Signature by Drawing Create New Signature X 

Draw Type Upload 

Sign here 

e)e e Clear 

Signature by Type Create New Signature X 

Draw Type Upload 

e) e • Clear 

2» Signature by Upload Create New Signature X 
image 

Draw Type Upload 

Drag & Drop your image here 

Or 

I Choose a signature] 

Stamp (Standard) [APPRove [As s] 
I COMPLETED 11 CONFIDENTIAL I 

[oewnvar] [oRiT 
I EXPERIMENTAL 11 EXPIRED I 

[iu] [on coved 
[FOR PUBLIC REL EASE] [INFORATON NY, 
[NOT APPROVED] [II RR RAC REIS 
I PREUMINARY RESULTS I I SOLD l 
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Stamp (Custom) Create New Stamp X 

Draft 
Antelope:1 31/08/2024 2:44 PM 

Stamp text 

Draft 

Font style 

Helvetica B I U A 
Text color 

Background color 

Timestamp text 

El username El Date E2 Time 

Date format @ 

DD/MM/YYYY h:mm A 

LE Image Either JPG or PNG format. 

File Attachment Attach any electronic file,double click to download 
BILL TO 

ABC COMPANY LIMITED V 
9 Call Out BILL rn < 11nsert text here 

ABC COMPANY LIMITED 

e. Edit 

Icon Feature Description / Sample 

t Crop Page 

f. Fill and Sign 

Icon Feature Description / Sample 

2» Signature Please refer to section V(d) 

T Free Text Please refer to section V (a) 
- - 
0 Cross Paste a cross on a form. 
- - 
0 Tick Paste a tick on a form. 
- 

- 

[·) Dot Paste a dot on a form. 

9 Stamp Please refer to section V(d) 
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- □ Calendar BILL TO 
ABC COMPANY LIMITED 2024-08-31 

g. Other Features 

Icon Feature Description / Sample 

[] Panel View page thumbnails, outlines and signature 
list. 

e Control • View document as continuous page/ page 
by page. 

• Page rotation 
• Page layout as single page/ double page 

234% V Zooming • Page zoom by percentage 
• Zoom to width, zoom to height 
• Marquee Zoom 

@ Menu • Full screen 
• Download PDF with/ without annotation 

Q Search Search within the PDF file. 

Note: For other documents like Microsoft® Office, CAD drawing, any annotation applied 

are only placed on the document preview version, it will not alert any of the original 
document. 

VI. Check-In and Unlock Document 

1. After you check-out a document for editing, you are required to check-in for saving. From 
the document viewer toolbar, select Edit> Check In. 

[] Edit :) @ ~ 

Check In El A 

Unlock 

Download 

Add to My Clipboard 
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2. The document is now saved as a new version. 
- Home > Samples > Accounting > Invoices > INV24001.pdf < > X 

tr Edrt Relation Share To Compare Index Reminder Redaction AI Genie 

Index List [] ~ 150% » 0 @ <!"J '.i 'Ver 2.0/by Antelope V a o' $ 
File Name INV24001 pdf 

Size 152 KB 

Version 2.0 3samplecor Version Date 2024-08-31 15.05:46 INVOICE 
Version By Antelope 

Invoice No INV24001 BILL TO 

ABC COMPANY LIMITED Invoice No. INV24001 
Invoice Date 2024-08-12 Flat A, IF, SampleCorp Innovation Tower, Invoice Date 10 June 2024 
Supplier Name ABC Company Causeway Bay, PO No. PO123016 

Hong Kong Due Date: Io July 2024 
PO No. PO12345 

Due Date 2024-09-11 

Total Amount 13560.0000 NO. PARTICULARS QTY (PCS) UNIT PRICE DISCOUNT % AMOUNT 
Line Items Details (2) 

I Product Item A 2 100.00 0.00 200.00 

3. If you want to discard any changes, select Unlock instead. 
Home > Samples > Accounting > Invoices > I 

Relation Share To Compare 

Check In 

Unlock 

Download 

Add to My Clipboard 

VII. Document Version 

1. A document will have version increment either by one of the following actions: 
a. A new document is uploaded and overwrite the original one. 
b. Annotation is applied on the document preview. 
c. The document is check-out for content editing and check-in again. 
d. A scanned document is uploaded and converted into searchable PDF. 

2. To view document version history, select the document, right click to bring up the context 
menu. 
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+ New v 7 Upload 

□
Eu 

Index v View V 

T File Name 

INV24001.pdf 

Change Column View 

Size 

Recycle Bin 

Version Version Date Version By 

---. - -· 15.09.17 Jennifer Tam 

e < 1to1 (Page1) v > 

Hash Tag 

#ABC #Invoice 

Invoice No. 

INV24001 
Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

Version History 

Circulation History 

3. The version history window will appear. 
Version History ff] x 

► File Name Version By Version Version Date 

@ e, INV24001.pdf Jennifer Tam 3.0 2024-08-31 15.09.18 

@ &9 ".Y l11J , INV24001.pdf Antelope 2.0 2024-08-31 15.05:46 

@ &9 ".Y l11J e, INV24001.pdf Antelope 1.0 2024-08-31 12.32.15 

4. Depends on your access permission, you can remove older version of documents by 

clicking the recycle bine icon. ® 
Version History ff] x 

► File Name Version By Version Version Date 

, INV24001.pdf 

e, INV24001.pdf 

Jennifer Tam 

Antelope 

3.0 

2.0 

2024-08-31 15.09.18 

2024-08-31 15.05:46 

5. You can also restore the older version of document as the latest one by clicking the 
restore icon• 

Version History ff] x 

► File Name Version By Version Version Date 

@ , INV24001.pdf Jennifer Tam 4.0 2024-08-31 15.32.39 

@ &9 ".Y l11J , INV24001.pdf Jennifer Tam 3.0 2024-08-31 15.09.18 

@ 9 ".Y a , INV24001.pdf Antelope 2.0 2024-08-31 15.05:46 
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VIII. Mark and Revert Final Version 

1. To mark a document as final version from further editing, from the document viewer 
toolbar, select Edit> Mark Final Version. 

Home > Samples > Accounting > Invoices > II 

Relation Share To Compare 

[] Check Out & Edit 

Check Out & Download 

Download 

Mark Final Version 

Add to My Clipboard 

2. You can also mark as final version by bring up the context menu, select Edit> Mark Final 
Version. 
+ New v 7 Upload Index v View v Change Column View Recycle Bin [E e' 

□
Eu 

File Name 

a - INV24001.pdf 

f Size Version Version Date Version By 

---- -- -- 5.32.39 Jennifer Tam 
Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

Historv 

Check Out & Edit 

Check Out & Download 

Download 

Check Out 

Mark Final Version 

Update Thumbnail 

Add Attachment 

Ha 

#Al 

3. Once a document is marked as final version, the document is sealed from further editing. 
+ New v T Upload Index V View V Change Column View Recycle Bin 8 e' 

□ File Name Istre Version Version Date Version By 

Eu * En . INV24001.pdf 152 KB 4.0 (Final) 2024-08-31 15.32.39 Jennifer Tam 

4. User with only manage rights or the document owner can revert the final version back to 
edit mode. 
+ New v T Upload Index V View V Change Column View Recycle Bin ( e 

□ File Name [stee Version Version Date Version By 

EI * » . INV24001.pdf 157 KR 4 (Final) 2024-08-31 15:32.39 Jennifer Tam 

Preview 

Edit 

Add to My Clipboard 

Relation 

Download 

Revert Final Version 
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IX. Minor Version Update 

1. To enable minor version of document, select a folder, right click to bring up the context 
menu, then select "Edit". 

> CJ Accounting 
> CJ Agreements 

> CJ Human Resources 

» C 
» 7 Logistic 

[] Management 

» Marketing 

> CJ Office Admin 

5, [7 sales 

Share To 

Update Thumbnail 

More 

Cut 

Copy 

11 

Delete 

Edit 

Follow 

Temporary Permission 

Permission 

2. Enable minor version, then click the blue "Update" button to save changes. 
Edit Update x 

General Advance 

Rule 

Filter Owner 

Minor Version 

O 
Max. Major Version 

Max. Minor Version 

3. Once minor version is enabled, document upload to the folder will start from Version 0.1. 
+ New V T Upload Index V View V Change Column View Recycle Bin @ 

□ T File Name Size Version Version Date 

LI tr a . Non-disclosure agreement.docx 85 KB 0.1 2024-09-01 01.28.31 

□ t » . Non-disclosure agreement.pdf 76 KB 1.0 2024-06-2115:07:06 

□ tr an . Real Estate Purchase Agreement.pdf 227 KB 1.0 2024-06-28 13.28.14 

4. Whenever there are any changes, the version number will increment by 0.1. 
version History ] x 

File Name Version By Version Version Date 

@ El Non-disclosure agreement.dox Jennifer Tam 0.2 2024-09-01 01.29.43 

@ 0 '.D a " Non-disclosure agreement.do Jennifer Tam 0.1 2024-09-01 01.28.32 

Note: User accounts without "manage" permission on the folder are not able to see the 
minor version of any documents, except the document owner himself/herself. 
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X. Publish Version 

1. To public a minor version of document as major version, select the document, right click 
to bring up the context menu, then select "Edit > Publish". 

+ New T Upload Index v View v Change Column View Recycle Bin [E 

□ T File Name Size Version Version Date Version By 

E tr a . Non-disclosure agreement.docx 24-09-01 01.29.43 Jennifer Tam 
Preview 

□ tr . Non-disclosure agreement.pdf . » Edit Check Out & Edit □ tr » . Real Estate Purchase Agreement.pd Add to My Clipboard Download 

□ tr » . Residential Lease Agreement.pdf Relation Check Out 

□ tr » . Sample Purchase Agreement of HRI Route Document Publish 

□ tr a . Sample Purchase Agreement.docx Share To Mark Final Version Tam 

Reminder Convert To PDF 

2. Once the document is published, the version number will become 1.0. 
+ New V T Upload Index v View v Change Column View Recycle Bin [O 

□
E 
□

[le Name 

* itiil • Non-disclosure agreement.docx 

7 » Non-disclosure agreement.pdf 

Size Version Version Date 

85 KB 

76 KB 

Version By 

1.0 2024-09-01 01.2943 Jennifer Tam 

1.0 2024-06-21 15.07.06 Antelope 

3. For any further modification, the document version will increment by 0.1. 
+ New V 7 Upload Index v View Change Column View Recycle Bin [O 

□
II 
□

[ rite Name 

* til .., Non-disclosure agreement.docx 

1 a » Non-disclosure agreement.pdf 

Size Version Version Date 

85 KB 

76 KB 

Version By 

1.1 2024-09-01 01.33.34 Jennifer Tam 

1.0 2024-06-21 15.07.06 Antelope 

4. Until the document is published to major version. 
+ New Upload Index v View v Change Column View Reycle Bin [ 

□
EI 
□

I File Name 

* itiil • Non-disclosure agreement.docx 

7 a » Non-disclosure agreement.pdf 

Size Version Version Date 

85 KB 

76 KB 

Version By 

2.0 2024-09-01 01.33.34 Jennifer Tam 

1.0 2024-06-21 15.07.06 Antelope 

XI. Update Thumbnail 

1. By default, some document types such as PDF, Microsoft Office documents and images 
can render with thumbnail view. In case some special document types which cannot be 
rendered and would like to have a thumbnail, you can upload a thumbnail image. 

2. Select the document from the document list, right click the bring up the context menu. 
Select Edit> Update Thumbnail. 
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+ New Upload Index View v Change Column View Recycle Bin [E 

□
EI 

T File Name 

» - INV24001.pdf 

Size Version 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

Historv 

Version Date Version By 

)8-31 15:32.39 Jennifer Tam 

Check Out & Edit 

Check Out & Download 

Download 

Check Out 

Mark Final Version 

Update Thumbnail 

Add Attachment 

3. The Update Thumbnail window will appear. Browse for JPG file with recommend 
resolutions of 500 x 500 pixels, then click "Upload" button. 
y 

Update Thumbnail Upload x 

Browse 20 MB JPEG File Only (500 x 500px) 

File Name: Xx 

4. Click the blue Upload button to commit changes. 

XII. Copy Document 

1. To copy a document, select the document from the document list, right click to bring up 
the context menu, select Copy. 

+ New 7 Upload Index v View v Change Column View Recycle Bin [E 

□
Eu 

T File Name 

a - INV24001.pdf 

Size Version 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

Version Date Version By 

4-08-31 15:32:39 Jennifer Tam 

2. Select the destination folder you want to paste, right click to bring up the context menu, 
select Paste. 
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• samples 

v D Accounting 
> D Invoice (2024) 

Paste Link 

D Invoices Share To ►
> D Purchase Orders Update Thumbnail 

> D Agreements More ►
> D Human Resources Cut 

> D IT Copy 

> D Logistic Paste 

3. Both the document and index are pasted in the destination folder. Be notice that only the 
latest version will be copied and pasted. = Name Keyword Search 

Home > Samples > Accounting > Invoice (2024) 

Folders + New T Upload Index View Change Column View Recycle Bin 

» [) Qc Profile A (Cojack) 

» [) QcPofte B (Enc Chan) 
» [) QcPofte c (Kevin) 
» [7 Qc Ponte D (wtson) 

» [7 Q€Profile E (Patrick) 

- samples 
• ) Accounting 

» [] invoice (2024) 
[) 1voices 

» _]Purchase orders 

□
□

[ ue Name 

7 a - INV24001.pdf 

Size Version 

152 KB 

Version Date Version By 

1.0 2024-08-31 15.57.39 Jennifer Tam 

XIII. Copy and Paste Index 

1. You can only copy the document index and paste onto another document profile only. 
For example, in the following case, the invoice in "Invoice (2024)" folder is well indexed, 
while the latter one contains only the document name. 

Name vl Keyword Search 

Home > Samples > Accounting > Invoice (2024) 

Folders 

» [) Q€Profile A (Coak) 

» QcPofle B (Erie Chan) 

> CJ QC Profi le C (Kelvin) 
» [7 QcProfile D (Wilson) 

» [JQcProfie E (Patrick) 
[) samples 

• Accounting » tvoie (a024) 
7 1voices 

» [] Purchase orders 

+ New V T Upload Index V View Change Column View Recyc le Bin 

□ [File Name Size Version Version Date Version By 

□ tr » . INV24001.pdf 152 KB 10 2024-08-31 15.57.39 Jennifer Tam 

e 

Hash Tag 

#Invoice #2024 

1to1 (Page1) v 
Invoice No. 

INV24001 

Invoice Date 

2024-08-12 
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= Name v l Keyword Search 

Home > Samples > A"ouoting > 1n,o;,es - 

Folders + New Upload Index View v Change Column View Recyc le Bin 

» [) Q€Profile A (Coak) 

» QcProtle B (Eric cha) 

» [7 QcProfie C (etvin) 
» 7 QcProfile D (Wilson) 

QcPonte E (Patrick) 

[) samples 

• Acounting 

» [) ivoie (2024) 

1voices 

» [] Purchase orders 

□
□

[File Name 

a - 329512.pdf 

Size Version Version Date Version By Hash Tag 

e 1to1 (Page1) v 

Invoice No. Invoice Date 

123 KB 1.0 2024-08-31 16.00 .23 Jennifer Tam 

2. Copy the source document. 
Keyword Search « a A 0 @ 

Home > Samples > Accounting > Invoice (2024) 

Folders 

QcPonte A (Cojacd) 

> CJ QC Profile B (Eric Chan) 
> CJ QCProfileC(Kelvin) 

> CJ QC Profile D (Wilson) 

» [7 QcProtie E (Patnik) 

• samples 

• Accounting 
» [] 1voice (2024) 
[) 1voices 

» [Purchase orders 

» [7 Agreements 

» [_] Human Resources 

DC 
» [7 ooistie 

+ New Upload Index View v Change Column View Recyc le Bin 

□
[Eu 

[pie Name 

? a - INV2400Lpdf 

Size Version Version Date Version By 

1 29« e 31 15.57.39 Jennifer Tam 
Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

e 

Hash Tag 

#invoice #2024 

1to1 (Page1) " 

Invoice No. 

INV24001 

Invoice Date 

2024-08-12 

3. Select the destination document, right click the bring up the context menu, select More> 
Paste Index. = Name v l Keyword Search « a A 0 @ 

Home > Samples > A"ou,ting > 1,,o;m - 

Folders 

> ] QcPofte A (Coak) 

» [7 QcProfile B (Eric Chan) 
» [7 Q€Profile C (Kelvin) 
» 7 QcPonte D (wison) 

» [7 QcProfile E (Patuid) 

• ) samples 

) Accounting 

» [] ivoie (2024) 

) trvoies 

» [) Purchase orders 
» [ Agreements 
» [_ Human Resources 
»Cr 
» oistie 

» [Management 

> Marketing 

» [ office Admin 

» sites 

+ New- Upload Index View Change Column View Recyc le Bin 

[E 
[pile Name 

? a - 329512.pdf 

Size Version Version Date Version By Hash Tag 

e 1to1 (Page1) " 

Invoice No. Invoice Date 

• sea 1 160023 Jennifer Tam 
Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

Document Properties 

Follow 

Temporary Permission 

Paste Index 

Delete 

Permission 

Audit Log 
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4. The destination document is now indexed with the original one. 
Keyword Search 

Home > Samples > Accounting > Invoices 

Folders + New Upload Index View Change Column View Recyc le Bin 

» ] QcProfile A (Cojack) 

» ] Q€Profile B (Eric Chan) 

» QcProfile C (Kelvin) 

> CJ QC Profile D (Wilson) 

QcProfile E (Patik) 

• samples 

• ] Accounting 

» ) invoice (2024) 
] tvoices 

» ) Purchase orders 

I­ 
[Eu 

[ File Name 

? a - 329512.pdf 

Size Version 

123 KB 

Version Date Version By 

10 2024-08-31 16.00.23 Jennifer Tam 

Hash Tag 

C' 1to1(Page1) » 

Invoice No 

INV24001 

Invoice Date 

2024-08-12 

XIV.Delete Document 

1. To delete a document, right click to bring up the context menu, select More> Delete. 
+ New" Upload Index View Change Column View Recyc le Bin O 

I­ 
[Eu 

[ue Name Size Version 

? INV2AOL.pdf Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Version Date Version By 

31 15.57.39 Jennifer Tam 

' 1to1(Page1) » » 

Hash Tag 

#Invoice #2024 

Invoice No. 

INV24001 

Invoice Date 

2024-08-12 

Copy 

Document Properties 

Follow 

Temporary Permission 

Delete 

Permission 

Audit Log 

2. A confirmation message will ask you for deleting. Choose Yes. The document will be put 
into Recycle Bin. 

XV. Move Document 

1. To move a document, drag and drop the document(s) from one folder to another. Bear in 
mind that you cannot drag either folder or document to the root (e.g. Home). 

2. If the document profile between the source and destination folders are difference, some 
document index may not be able to inherit. 

XVI. Add Attachment 

1. To add an attachment, select the document, right-click to bring up the context menu, and 
then select Edit> Add Attachment. 
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+ New V Upload Index View Change Column View Recycle Bin @ 

□
EI 

T File Name 

ta - INV24001.pdf 

Size Version 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

Version Date Version By 

-31 15:57.39 Jennifer Tam 

Check Out & Edit 

Check Out & Download 

Download 

Check Out 

Mark Final Version 

Update Thumbnail 

Add Attachment 

2. Browse the file to upload. 

Upload Document Upload x 

Browse (20 MB Only) 

File Name: PO-150034.pdf X 

Larger file(s) can be uploaded through MS Office Plug-in or Drag and Drop. 

3. A clip icon will appear in the document. You can add multiple attachments to a single 
document. 
+ New V 7 Upload 

□
□

Index v View V Change Column View 

T File Name 

INV24001.pdf 

Size Version 

Recycle Bin 

152 KB 

Version Date 

@ 

Version By 

1.0 2024-08-3115:57:39 Jennifer Tam 
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XVII. View Attachment 

1. To view the attachment, open the document for preview. 
Home> Samples > Accounting > Invoice (2024) > INV2400Lpdf @ x 

? Edit Relation Share To Compare Index Reminder Redaction AI Genie 

Index List 

File Name 

Size 

Version 

Version Date 

Version By 

Hash Tag 

Invoice No. 

Invoice Date 

PO No. 

Due Date 

Supplier Name 

Total Amount 

Line Items 

New Field 

INV24001 pdf 

152 KB 

1.0 

2024-08-31 15.57.39 

Details 

Attachment , PO-150034.pdf 

D e ox­ 

BILL TO 
ABC COMPANY LIMITED 
Flat A, I0F, SampleCorp Innovation Tower, 
Causeway Bay, 
Hong Kong 

Invoice No. 
Invoice Date 
PO No. 
Due Date: 

Ver 1.0/by Jennifer Tam 

Jennifer Tam 

#Invoice #2024 

INV24001 

2024-08-12 

PO12345 

2024-09-11 

ABC Company 

0.0000 

3sarptecor INVOICE 

INV24001 
10 June 2024 
PO123016 
Io July 2024 

NO. PARTICULARS QTY(PCS) UNIT PRICE DISCOUNT % AMOUNT 

Product Item A 

Product Item B 

100.00 

1o0.00 

0.00 

0.00 

200.00 

1o0.00 

2. The attachment is display above the annotation toolbar. 

Attachment PO-150034.pdf z» 
ID 150% V @ 

3. Click the attachment name to open for preview. 
E Home> Samples > Accounting > Invoice (2024) > INV24001pdf >» PO-150034Apdf Xx 

Share To Index 

Index List 

File Name 

Size 
Version 

Version Date 

Version By 

Hash Tag 

[] e@ ox @ 

PO-150034.pdf 

476 KB 

1.0 

2024-08-31 16.13.17 3sarpteCor PURCHASE ORDER 

Customer Name: Payment: 

TAI CHAN JEWELLERY 30 DAYS 

PO No. 

Po Date 

Ver 1.0/by Jennifer Tam 

PO-150036 

2015-07-03 

Quotation No. QUO-0027 

Currency HKD 

ltem # Deseription Qty Price Extended Price 

1522 Les Grands Chenes Medoc CB 2011 3-Pack I S540.00 S540.00 

1510 Feudo Maccari Saia Sicilla 2011 6-Pack 2 $1,308.00 $2.616.00 

1503 Beaurenard Rasteau Village 2011 3-Pack I $534.00 S534.00 

1489 D' Arenberg The Laughing Magple 2010 I S1,128.00 $2.256.00 

Grand Total $5,946.00 

Note: You can only share and rename attachment. 

XVIII.Add to My Clipboard 

1. To add a document to clipboard, select the document, right click to bring up the context 
menu, then select "Add to My Clipboard". 
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+ New Upload 

□
E 

Index View 

f File Name 

{7 ca - INV24001.pdf 

Size 

Change Column View 

Version 

Recycle Bin 

TV 

Preview 

Version Date 

e 

Version By 

1 2024.09.31 15:57.39 Jennifer Tam 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

2. You can add multiple documents to clipboard. 
Keyword Search 

Quick Access > My Clipboard 

Folders 

i] Quick Access 

[a My check out 

[) My Favorites 

{] My clipboard 

(O) Recent Open Doc uments 

] Personal Folder 

8 

□ [iie Name 

[ I t, En INV24001.pdf 

□ do Sample.pptx 

Size Version Version Date Version By 

152KB 10 2024-08-31 15.57.39 Jennifer Tam 

687KB 1.0 2024-08-31 12.34.55 Antelope 

C' 1to2(Page1) » 

Folder Path 

Home\Samples\Accounting\invoice (2024) 

Home\QC Profile A (Cojack) 

Note: My Clipboard only stores documents temporarily, like search history. It will be 
cleared once you refresh your page or log out. 

0. Document Relation 
I. Copy Link 

1. To link up two documents, you can use the document link features. For example, if you 
want to establish a link which "connect" a purchase order to an invoice, select "Relation 
> Copy Link" from the context menu. 
+ New V 7 Upload Index v View Change Column View Recycle Bin [E) 

D f File Name 

E tr an . PO-150001.pdf 

D tr » . PO-150002.pdf 

D tr » . PO-150003.pdf 

Size Version Version Date 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

Version By 

• >>·.07-08 11.35.14 Antelope 

-07-08 11:35:14 Antelope 

-07-08 11:35:14 Antelope 

Copy Link 

linked Relations 

Group Document 

2. Select the destination document, right click to bring up the context menu, then select 
"Relation> Paste Link". 
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+ New T Upload Index View v Change Column View Recycle Bin [E 

D 
E 

T File Name 

aa - INV24001.pdf 

Size Version 

152 KR 

Version Date Version By 

10 2024-408-31 15-67.39 Jennifer Tam 

Hash Tag 

#Invoice #2024 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

Copy link 

Paste link 

Linked Relations 

Group Document 

3. A virtual link is established. 

+ New V 1' Upload Index View V Change Column View Recycle Bin (@ 

□ [ File Name Size Version Version Date Version By 

□ 0 tr EE» . INV24001.pdf 152 KB 1.0 2024-08-31 15.57.39 Jennifer Tam 

II. Link Relation 

1. To view the link relation, select the destination document, right click to bring up the 

context menu, then select "Relation > Linked Relations". 

+ New 7 Upload 

□
[Eu 

Index v View V Change Column View 

T File Name Size Version Version Date 

{7 a» - INV24001.pdf Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Recycle Bin @ 

Version By 

L 15:57.39 Jennifer Tam 

Copy Link 

Linked Relations 

Group Document 
Reminder 

Comoare 

2. The Linked Relations window display all virtual linkage to the document. You can preview, 
shared and delete the linkage. 

Linked Relations ff] x 

File Name Folder Path 

@ @ s [} P-150001.pdf Home\Samples\Accounting\Pur 

Ill. Group Document 

1. You can group multiple document type into a single PDF file by Group Document. This 

feature only support DOC, DOCX, XLS, XLSX, PPT, PPTX, RTF and PDF format. 
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2. Select the documents you want to group together, right click the bring up the context 
menu, select "Relations> Group Document". 

Group Document X 

The following files will be grouped as a new PDF File(support Word, Excel, PowerPoint & PDF only) 

L Word.rtf 

Version 1.0 Xx 

2024-08-3113:50:25 

X 
2023 :tjcfl/Jt~l!i'l!l!J1!1,la~!Rl!;.xlsx 

I Version LO 

2024-08-31 12:33:49 

X 

INV24001.pdf 

Version 1.0 

2024-08-31 16.01.31 

Xx 

PowerPoint.ppt 

Version 1.0 

2024-08-31 13.50.26 

Xx 

Word.doc 

EEI 
3. Rearrange the document sequence to group, then click the blue "Generate" button. 

4. Select the destination folder and input a document name, click the "tick" button to save. 
Select Folder x 

- Home > Samples 

[ le Name Size Version Version Date Hash Tag 

Accounting 2024-06-28 13.58:40 

Agreements 2024-08-28 21.28.30 

Human Resources 2024-06-28 13.58.57 

IT 2024-06-28 13.59.05 

Logistic 2024-07-08 11.38.13 

Management 2024-08-28 09.10.12 

Marketing 2024-07-08 11.38.00 

Office Admin 2024-06-28 13.59.18 

Sales 2024-07-08 11.38.19 

1to 9 (Page 1) 

Version By 

Filename: [Proposal 2024 

5. Once the document is generated, you can preview the document with thumbnail 
enabled. All "component documents" are displayed as virtual linkage. 
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Home> Samples> Proposal 2024pdf @ x 

Edit Rela tion Share.lo Compare Index Reminder Redaction AI Genie 

ohmnt an a0z Rn. [Q vauoo an 
D al ws- I 

er ­ - 
ION Project 

lDlil] 

8sampleCor INVOICE 

LAD .... . 
lg 

6. You can further modify the group document by adding or removing the components. 
I 11 /, * E:a • Proposal 2024.pdf 1 MB 1 n 7074-0R-~1 17·nn·n7 Jennifer Tam 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Copy Link 

Linked Relations 

Modify Group Document 
Reminder 

7. In this case, we removed the Excel spreadsheet, RTF file and the PDF. Finally click the 
blue "Re-Generate" button. 

Group Document X 

The following files will be grouped as a new PDF File(support Word, Excel, PowerPoint & PDF only) 

E 

PowerPoint.ppt 

Version LO 

2024-08-31 13.50.26 

Word.doc 

Version LO 

2024-08-31 13.50.26 

« IEE 
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P. Route Document 

I. Create New Routing 

1. You can route a document for single-step approval or review without setting up a 

workflow diagram. Select "Route Document" from the context menu. 

+ New V T Upload Index v View v Change Column View Recycle Bin [E 

□
E 

l File Name 

INV24001.pdf 

Size Version 

152 KB 

Version Date Version By 

1.0 2024-08-31 15:57.39 Jennifer Tam 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

2. The Route Document window will appear. Select the priority with either Low, Normal, 
High or Top. 

Document Workflow Next x 

Workflow Template Adhoc routing Priority [-_N_or_m_a_l -------~v] 

To: 

3. Select the recipient(s) either by user account or user group. 

Document Workflow Next x 

Workflow Template Adhoc routing Priority Normal 

To: Jennifer Tam;User1 

4. Input both the Subject and Body. The subject will appear in both email and Workflow 
lnbox, while the Body will appear in email notification. 
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1 
Document Workflow Next x 

Workflow Template Adhoc routing Priority Normal 

To: Jennifer Tam;User1 

Subject· Please review the Invoice 

Body: I will send the invoice to ABC Company this Tuesday, please review and 
approve. 

5. Select the Due Date and Cancel After Date. If your recipients do not response to your 
request, the system will keep sending email reminder every midnight until it reaches the 
"Cancel After" date. 

Due before: 2024-09-03 

Cancel after : 2024-09-06 

6. There are several types of action for routing. 
Type Description Action Buttons 
Collaborate When the recipient receives this request, Reply, Completed 

they can make changes on the 
documents or place annotation, send 
back to the originator to and fro. Until 
the originator confirmed completed. 

Approve Approve or reject the document. Approve, Reject 
Review Ask for review only Reviewed 
Notification Ask for read notification. Read 

7. The scope will take effect when there are more than one recipient. 

Scope Description 
All All recipients must reply or approve (in case the type is approval 

request). 
Major Over or equal to 50% of recipients reply or approve. 
Any Any one of the recipients reply or approve. 

Type: Notification 

Scope: Any 
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8. In case you want the recipient to receive the document as attachment in the email 
notification, please check on this option. Bear in mind if the document size is over a 
certain limit, the recipient email server may not be able to receive. 

Include original : D I 

Q. Sharing 

I. Share to Internal 

1. To share a document link to internal user, select "Share To > Internal". 

-} New ; Upload Index v View v Change Column View Recycle Bin [E) 

□
E 

T File Name Size 

7 a - INV24003 (2).f 
Preview 

17 Lu 

Version Version Date 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

Internal 

Share to Guest 

Version By 

• o94-09-10 23.03:47 Wing 

2. Your default email client will bring up with the document link being pasted in the email 
body, for example: 

https://apac.antelopecloud.net/demo/main.aspx?sld=MPMBJNACIPIJPINGKKLXXXX 

3. Bear in mind user account without access permission cannot access the document 
content even with the document link. 
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II. Share to Guest 

1. To share a document link to guest, select "Share To> Share to Guest". 

+ New > 7 Upload Index View Change Column View Recycle Bin [E 

□
□
Eu 
□
□

[Fie Name 

EP-42 

EP­ 

Size Ve 

EP­ 

EP-0 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

13 KB 

13 KB 

13 KB 

13 KB 

Internal 

Share to Guest 

2. The Share to Guest window will appear. Input a 12-digits password, the password should 
contain at least 1 upper letter, 1 lower letter and 1 numeric letter. Select the date range. 
Finally click the "Generate Link & Send" button. 

Share to Guest x 

El ea»ea 

[7c-« 

File Link 

At least 12 characters with at least 1 upper letter, 1 lower letter and 1 numeric letter 

2024-09-10 To 2024-09-15 

Generate Link & Send 

3. Once the document link is generated, you can copy the link by clicking the G icon. 
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- 
Share to Guest X 

El we« 

At least 12 characters with at least 1 upper letter, 1 lower letter and 1 numeric letter 

El ua« 2024-09-10 To 2024-09-16 

File Link o 

EE 

4. To remove the shared link, click the blue "Remove Link" button. 

Noted: Unlike Share to Internal, the external share link to guest only shares the "current 
version" of document. In case there is a newer version of document published, you are 
required to generate a new share link again. 

5. Once your recipient receives the email, they can download the document. 

Document Download Link 

• 

wing.mak@antelope.asia <wing.mak@antelope.asia> 

To: jennifer@antelope.asia 

Dear Jennifer, 

Download link as below. Thanks. 
https:/lapac. antelopecloud. net/internalqc/getfite/PP[LAADOGAEIAJLHOMDBMGAKJNKEIMKII 

Best regards, 
Wing 

Ill. My Shared Links to External 

1. While you may share different documents to different guests, you can centralize manage 
all your share links through "My Shared Links to Guest" 
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My Account 

My Shared Links to Guest 

My Reminder Record 

My Workflow Delegation 

2. You can copy or remove the shared link at any time. 
My Shared Links to Guest ff] x 

File Name Folder Path Shared Version Link Created On Set Password Period From Period To 

O PO-150001.pdf 

O INV24001.pdf 

Home\Samples\Accounting\Purchase Orders 1.0 

Home\Samples\Accounting\invoice (2024) 1.0 

2024-08-31 

2024-08-31 2024-08-31 2024-09-06 

R. Reminder 

I. Create New Reminder 

1. To create reminder schedule, select "Reminder" from the context menu. 
+ New V 7 Upload Index v View V Change Column View Recycle Bin R 

□
II 

l File Name 

7 ta» - INV24001.pdf 

Size 

152 KB 

Version Version Date 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

Version By 

:39 Jennifer Tam 

2. The Reminder window will appear. 
Reminder 

► Initiator Follow-up Party Other Related Parties Reminder Date 

3. Select the user account for follow-up (To) and other related parties (cc), reminder date 
and follow-up action. 
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Reminder 

► Initiator Follow-up 
Party 

Other Related Reminder Date Follow-up Action 
Parties 

Status 

Wing User1 2024-09-13 

Send to ABC customer] 

4. Click add icon to commit changes. 

5. A new reminder record for the document is created. Both Wing and User1 will receive an 
email reminder on the selected date. 

Reminder 

Initiator Follow-up 
Party 

wing Wing 

Other Related Reminder Date Follow-up Action 
Parties 

User1 2024-09-13 Send to ABC customer 

Status 

Upcoming 

Last Edited On 

2024-09-10 

Last Edited By 

Wing 

New Reminder Created by Wing 

o workflow@system.com <workflow@system.com> 

To: wing.mak@antelope.asia 

Please be informed that a reminder is newly created for an eDMS document as follows. 

File Name INV720_001.pdf: https;/lapac.antelopecloud.net/internalqc/Doc View.aspx2sld=3598 

Initiator Wing 

Follow-up Party Wing 

Other Related Parties User l 

Reminder Date 2024-09-13 

Follow-up Action Send to ABC customer 

System No. [systemNo] 

II. My Reminder Record 

1. While you may set different reminders, you can centralize manage all your reminder 
schedules through "My Reminder Record". 

My Account 

My Shared Links to Guest 

My Reminder Record 

My Workflow Delegation 
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2. Within the "My Reminder Record" window, you can change the schedule details 

including recipients, reminder date and follow up actions. 
My Reminder Record 

File Name Folder Path [initiator Follow-up 
Party 

@] INV0720_001.pdf Home\Accounting Wing Wing 

Other Related Reminder Date Follow-up Action 
Parties 

User1 

Status 

2024-09-13 Send to ABC customer Upcoming 

Last Edited On 

2024-09-10 

Last Edited By 

Wing 

3. To delete the reminder, click the recycle bin icon. 

S. Compare 

I. Text Compare 

1. To compare two documents in plain text mode, select "Compare> Text Compare". 

□
Eu 

Sample Purchase Agreement of HRMS.pdf 

Sample Purchase Agreement.docx 
Preview 

72 KB 1.0 2024-06-21 14.54.52 Antelope 

--4-09-01 01.16.25 Jennifer Tam 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

Text Compare 

2. A two-sided document viewer will appear. 
Sam ple Purchase Ag reemen t doo42 0) 

ls~PLEMCHAStNGACiAEEEIWT 

5a mple Purchase Agreement doo42 0) 

This Purchasing Agreement ("Agreement") is entered into by and between Copany A, re 

WHEREAS, ABC Company desires to purchase a Human Resource Management 5ysten (HRMS) f 

EREA5, DEF Copany is willing to provide the HRS to Copay A, subject to the ter 

NM, THEREFORE, in consideration of the mutual covenants and promises contained here 

I. Date of Agreement; 

This Agreement is effective as of 1Ith October 2824, 

2. Scope of Work: 

DEF Copany shall provide ABC Copany with a fully functional Human Resource Manage 

3. Price and Payment Terms: 

The total purchase price for the HM5 is agreed upon as $400, 000. 9@. 

I 
b. ABC Company shall .. ke the first payment of uee,eet.tton the date of 12th Hove 

€, The remaining balance shall be paid by ABC Company to DEF Company in 1@ equal in 

d. All payments shall be made in 0NG KONG DOLLARS to the bank account specified by 

4. Delivery and Installation: 

This Purchasing Agreement ("Agreement") is entered into by and between Company A, re 

EREAS, ABC Copany desires to purchase a human Resource Management System (HRMS) f 

EREA, DEF Copay is willing to provide the HRS to Company , subject to the ter 

NOW, THEREFORE, in consideration of the mutual covenants and proises contained here 

1. Date of Agreement: 

This Agreement is effective as of 11th October 2824, 

2. Scope of work: 

DEF Copany shall provide ABC Copany with a fully functional Huan Resource Manage 

3, Price and Payment Ters: 

The total purchase price for the HRs is agreed upon as $400, 000. @, 

b. ABC Copany shall make the first payment of $100,000.80 on the date of 12th Move 

€ The remaining balance shall be paid by ABC Company to DEF Copany in 18 equal in 

d All payments shall be de in HN6 KONG DOLLARS to the bank account specified by 

4, Delivery and Installation: 

3. Select different versions on both sides. 

[j 
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4. The documents will highlight for any difference between the two versions. 
Sample Purcha se Agreemen t do42. 0) » 5ample Purchase Agreemen t do410) 

­ This Purchasing Agreement ("Agreement") is entered into by and between Company+ This Purchasing Agreement ("Agreement") is entered into by and between Copany A, 

aegis, ic Company desires to purchase a Human Resource »9nt 5ysten (HR WHEREAS, Company A desires to purchase a Human Resource Mn9et System (HRMS) 

WHEREAS, DEF Copay 1s willing 19 provide the HRS to Copany » 0)t to th ERAS, Company 8 1s illung 19 provide the HRHS to Company A, subject to the te 

Ni, THEREFORE, in consideration of the mutual covenants and promises contained NON, THEREFORE, in consideration of the mutual covenants and promises contained 

I. Date of Agreement: 1 Date of Agreement: 

This Agreement is effective as of Ith October 2824, mis Agreement is effective as of 1Ith October 2823, 

2. Scope of Work; 2. Scope of Work; 

DEF Company shall provide ABC Copany with a fully functional Huan Resource Mar pany B shall provide Company A with a fully functional Huan Resource Manageme 

3, Price and Payment fers; 3, Price and Payment Terms; 

a, The total purchase price for the HR5 is agreed upon as $400,008.88, The total purchase price for the HM5 is agreed upon as $400, 00@. 9, 

et Company shall make the first payment of $100,008.90 on the date of 12th b. Company A shall make the first payment of $108,000.90 on the date of 12th Nov 

The remaining balance shall be paid by ABC Company to DEF Company in 10 equ , The remaining balance shall " aid by Company A to Company B in 10 equal ins 

d. All payments shall be ode in NG KONG DOLLARS to the bank account specif d. All payments shall be ade in H0NG KONG DOLLARS to the bank account specified 

4, Delivery and Installation; 4. Delivery and Installation: 

T. Document Audit Log 

I. Document Audit Log 

1. To view a document audit log, select the document, right click to bring up the context 

menu, then select "More > Audit Log". 

E 
□
□
□
□
□

Non-disclosure agreement.docx 

Non-disclosure agreement.pdf 

Real Estate Purchase Agreement 

Residential Lease Agreement.pd· 

7 » Sample Purchase Agreement of I 

* • . Sample Purchase Agreement.docx 

Preview 

Edit 

Add to My Clipboard 

Relation 

Route Document 

Share To 

Reminder 

Compare 

History 

More 

Cut 

Copy 

2024-09-01 01.33.34 Jennifer Tam 

2024-06-21 15:0706 Antelope 

2024-06-28 13:28:14 Antelope 

2024-06-28 13:28:21 Antelope 

2024-06-21 14.54.52 Antelope 

» 2024-09-01 01.16.25 Jennifer Tam 

Document Properties 

Follow 

Temporary Permission 

Delete 

Permission 

Audit Log 
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2. The document audit log window will appear. 
Audit Log 

Document - Publish 

Preview- Update 

Thumbnail - Update 

Thumbnail - Update 

Document - Access Content 2024-09-01 01.33.37 

Document - Access Content 2024-09-01 01.33.35 

Document - Check In 2024-09-01 01.33.35 

Documen t - Check Out 2024-09-01 01.33.34 

Documen t - Publish 2024-09-01 01.32.43 

Previ ew.- Update 2024-09-01 01.29.51 

Thumbnail - Update 

Thumbnail - Update 

Preview- Update 

Thumbnail - Update 

Thumbnail - Update 

2024-09-01 01.34.39 

2024-09-01 01.33.41 

2024-09-01 01.3340 

2024-09.-01 01.3340 

2024-09-01 01.29.50 

2024-09-01 01.29.49 
Document - Access Content 2024-09-01 0129.45 

Documen t - Access Content 2024-09.-01 01.29.45 

Document - Check In 2024-09-01 01.29.43 

Document - Check Out 2024-09-01 01.29.43 

2024-09-01 01.2840 

2024-09-01 01.28.39 

2024-09-01 01.2838 

Document - Access Content 2024-09-01 01.28.35 

Document - Access Content 2024-09-01 01.28.34 

Document - Create 2024-09-01 01.28.32 

Jennifer Tam 172.31.5.29 Vers ion=1.1 

Documen t Service Account l 

Document Service Account l 

Document Service Account l 

Indexing Servi ce Account EC2AMAZ -JM0. 

Document Service Account l 

Jennifer Tam 172.31.529 Vers ion=1.1 

Jennifer Tam 172.31.529 Vers ion=1.0 

Jennifer Tam 172.31.529 Vers ion=0.2 

Document Service Account zl 

Document Service Account l 

Documen t Service Account l 

Indexing Servi ce Account EC2AMAZ-JM0. 

Document Service Account l 

Jennifer Tam 172.31.31.146 Vers ion=0.2 

Jennifer Tam 172.31.31.146 Vers ion=0.1 

Document Service Account l 

Documen t Service Account l 

Document Service Account zl 

Indexing Servi ce Account EC2AMAZ -JM0. 

Document Service Account l 

Jennifer Tam 172.31.31.146 

Version= 2.0 

Version=l.1 

Version=l.l 

Version=l.1 

Version=1.0 

Version=0.2 

Version=0.2 

Vers ion=0.2 

Version=0.I 

Version=0.1 

(1) 

3. The audit log contains information including log type, log date, document owner, IP 
address, original value and new value. 

4. To search the document audit log, click the search icon to bring up the search panel on 
the left-hand side. 

Field name Criteria 

Log type 

Log Date 

Log Date 

equal 

greater or equal 

less or equal 

Document - Publish 

Preview- Update 

Thumbnail - Update 

Thumbna il - Update 

Owner contain 

IP address contain 

Original Value contain 

New Value contain 

Document - Access Content 2024-09-01 01.33.37 

Document - Access Content 2024-09-01 01.33.35 

Document - Check In 2024-09-01 01.33.35 

Documen t - Check Out 2024-09-01 01.33.34 

Add Document - Publish 

Preview.- Update 

2024-09-01 01.34 .39 

2024-09-01 01.3341 

2024-09-01 01.3340 

2024-09.-01 01.3340 

2024-09-01 01.32.43 

2024-09-01 01.29.51 

Thumbna il Update 2024-09-01 01.29.50 

Thumbna il Update 2024-09-01 01.29.49 

Document Access Content 2024-09-01 01.29.45 

Jennifer Tam 172315.29 Ver 

Document Service Account l 

Document Service Account l 

Document Service Account l 

Indexing Service Account EC2AMAZ-JM0. 

Document Service Account l 

Jennifer Tam 172.31.5.29 Ver 

Jennifer Tam 172.31.5.29 Ver 

Jennifer Tam 172.31.5.29 Ver 

Document Service Account zl 

Document Service Account l 

Document Service Account l 

Indexing Servic e Account EC2AMAZ-JM0. 

5. Search the audit log by defining different search criteria, for example, Log Type 
"Preview- Update", then click the "Search" button. 
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Field name Criteria 

Log type 

Log Date 

equal 

greater or equal 

Preview Update 

Preview.- Update 

Preview- Update 

Preview- Update 

2024-09-01 01.33.41 

2024-09-01 0129.51 
2024-09-01 0128.40 

Document Service Account l 

Document Service Account l 

Document Service Account l 

Log Date less or equal 
Owner contain 

IP address contain 

Original Value contain 

New Value contain 

Add 

6. You can export the search result in either Excel spreadsheet or PDF file. 
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